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FCC Note
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About this manual

Purpose of this manual

This manual tells you how to install, configure and use the Perle SX system hardware, 
associated drivers and utility software. 

Who this manual is for

This manual is aimed at users who want to connect peripherals and terminals to a host using 
the Perle SX serial connectivity system. This manual requires a working knowledge of using 
personal computers and associated operating systems, as well as experience in installing 
host cards and peripherals.

Warning

Dangerous voltages exist inside computer systems. Before 
installing host cards in your system, turn off the power supply 
and disconnect the mains lead.
SX User Guide 
Purpose of this manual
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Using this on-line manual

The following is a brief guide to using this manual on-line.

Document navigation

This manual features document navigation hypertext buttons in the header area as shown in 
the next picture;

Hypertext jumps

You can also navigate around this manual by clicking on any cross reference or text in blue 
for example, Hypertext jumps. 

Jump to Using this on-line manual

Jump to Index

Jump to Quick Reference 

Jump to previous location 

Jump to front of current chapter

Jump to Contents

Jump to Fast contents

Note

The Fast Contents, Contents and Index entries are all hypertext 
jumps into this manual.
SX User Guide 
Using this on-line manual
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Chapter 1  Introduction

You need to read 
this chapter if you 
want to...

You need to read this chapter if you want an introduction to the Perle SX serial connectivity 
system.

This chapter provides introductory information about the Perle SX serial connectivity system, 
its associated components, driver software and configuration utilities.

This chapter includes the following sections;

• About the SX system on page 19

• System components on page 20
SX User Guide 
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About the SX system

The Perle SX Product Range is a high performance, intelligent, expandible connectivity 
system for up to 128 serial devices which provides up to 32 ports per host card. The SX 
Universal PCI version of the system is based on the Motorola ColdFire processor and offers 
superior performance to the previous SX host cards. See also System components on 
page 20.

Typical uses of the system include RAS for NT, Internet Service Providers, corporate remote 
access, retail EPOS, industrial process control, dial out modems and printing. You can use 
the SX system in a wide range of industries including hotel/leisure management, banking 
and finance, manufacturing, real estate and telecommunications.

Typically, you use this product because you want a low cost connectivity system optimised 
for delivering high performance on multi-user systems and remote access server 
environments.

PC server

SX Host
card

RAS connection

Modem

EPOS

Printers

Data collectors

Internet
Dialup client

Dial out connection

Note

SX is 100% compatible with older SX terminal adaptors and device concentrators.
SX User Guide 
About the SX system
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System components

This section provides a brief description of the main components of the SX system and 
includes the following.

• Host card on page 20

• 1.5 metre bus extension cable on page 20

• Device concentrators and terminal adaptors on page 20

Host card

Host cards provide system connection to Device concentrators (SXDCs), terminal adaptors 
(TAs) and Modular Terminal Adaptors (MTAs) and are available in ISA and PCI formats. See 
also Installing a Universal 3.3/5V PCI host card on page 131, Installing an ISA host 
card on page 133 and Removing host cards on page 135 in Chapter 2 Installing 
hardware and software.

1.5 metre bus extension cable

A proprietary 1.5 metre bus extension cable is supplied with the host cards which allows you 
to link host cards to Device concentrators or terminal adaptors. 

Device concentrators and terminal adaptors

Device Concentrators (SXDCs), Terminal Adaptors (TAs) and Modular Terminal Adaptors 
(MTAs) are basically serial connection blocks which provide a number of ports depending on 
type. See Example SXDC8 device concentrator on page 22, Example MTA8 modular 
terminal adaptor on page 23 and Example TA4 terminal adaptor on page 24 for pictures 
of typical examples.The range of types available for the SX system are shown in Overview 
of device concentrators and terminal adaptors on page 21.

Note

When connecting SX host cards to Device concentrators or terminal adaptors you 
should only use the 1.5 metre bus extension cable supplied with your SX host 
card. Using any other cable will invalidate your EMC and noise warranty 
and may cause system lockups and crashes.

Note

The permitted combinations of device concentrator types are as follows:

SXDC8s to SXDC8s
MTAs to MTAs, and 
TA4s/TA8s to TA4s/TA8s
SX User Guide 
System components
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Overview of device concentrators and terminal adaptors

Device 
Concentrator

Number 
of ports Type 

For 
information 
on installing 
see...

SXDC8/RJX 8 RS232 RJ45 ports with high performance and ESD 
protection to 15kV. 

See page 137.

SXDC8/DX 8 RS232 DB25 female DCE ports with high performance 
and ESD protection to 15kV

SXDC8/MX 8 RS232 DB25 male DTE ports with high performance and 
ESD protection to 15kV. Emulates standard PC COM 
port pinouts

SXDC8/PX 8 1 x DB25 Parallel, 7 x RS232 DB25 female DCE ports 
with high performance and ESD protection to 15kV

Refer to table on page 165 for further details.

SXDC8/422 8 RS422 DB25 female DCE ports with high performance 
and ESD protection to 15kV.

MTA8/RJX 8 RS232 RJ45 ports with ESD protection to 15kV. See page 142.

MTA8/DX 8 RS232 DB25 female DCE ports with ESD protection to 
15kV 

MTA8/MX 8 RS232 DB25 male DTE ports & surge suppression

Note these pinouts are the same as the SXDC8/MX.

MTA8/PX 8 1 x DB25 Parallel, 7 x RS232 DB25 female DCE ports 
with high performance and ESD protection to 15kV

Refer to table on page 165 for further details.

MTA8/422 8 RS422 DB25 female ports

TA4 4 RS232 DB25 female ports (/dx pinouts) See page 146

TA8 8 RS232 ESD protected to 15kV ports with DB25 female 
connectors (/DX pinouts)
SX User Guide 
System components

Page 21

Chapter 1 Introduction



Example SXDC8 device concentrator

37 way male D type 
connector for joining 
SXDCS together 
See page 138

Removable cover 
(lift vertically) 
See page 137

Port active LED 
for ports 5 to 8

Port active LED 
for ports 1 to 4

37 way female D type 
connector for joining 
SXDCS together 
See page 138
SX User Guide 
System components
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Example MTA8 modular terminal adaptor

37 way male D type 
connector for joining 
MTAs together. 
See page 143.

Removable cover (lift vertically).
See page 142.

Port active LED 
for ports 5 to 8.

Port active LED 
for ports 1 to 4.

37 way female D 
type connector for 
joining MTAs 
together.
See page 143.
SX User Guide 
System components
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Example TA4 terminal adaptor

Port active LED 
for ports 1 to 4.

37 way female D type connector for 
joining TAs together. See page 147.

37 way male D type connector for 
joining TAs together. See page 147.
SX User Guide 
System components
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Chapter 2  Installing hardware and software

You need to read 
this chapter if you 
want to.....

You need to read this chapter because you want to install SX device concentrators, host 
cards and associated software.

This chapter tells you how to install and configure SX device concentrators, host cards and 
associated software under the currently supported operating systems.

This chapter includes the following sections;

• Before you start on page 26

• Down loading SX drivers from the Perle web site on page 27

• Installing SX under Solaris on page 28

• Installing SX under SCO OpenServer 5 on page 40

• Installing SX under SCO OpenServer 6 on page 62

• Installing SX under SCO UnixWare on page 78

• Installing SX under Windows NT on page 105

• Installing SX PCI host cards under Windows 2000/XP/Server 2003/Vista/Server 
2008 on page 106

• Installing SX ISA host cards under Windows 2000 on page 112

• Installing SX under Linux on page 123

• Installing a Universal 3.3/5V PCI host card on page 131

• Installing an ISA host card on page 133

• Removing host cards on page 135

• Installing device concentrators on page 136

• Removing Device Concentrators from your system on page 149
SX User Guide 
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Before you start

Before installing your SX hardware and software, note that the procedure for installing and 
configuring SX hardware varies for different operating systems.

To install under a particular operating system, please refer to one of the operating system 
specific installation procedures listed below;

• Installing SX under Solaris on page 28

• Installing SX under SCO OpenServer 5 on page 40

• Installing SX under SCO UnixWare on page 78

• Installing SX under Windows NT on page 105

• Installing SX ISA host cards under Windows 2000 on page 112

• Installing SX under Linux on page 123

Note

The SX drivers support all previous SX and SI host cards in both ISA and PCI bus types and 
associated hardware.

Note

You can find the drivers for SX on the CDROM supplied with this product.
SX User Guide 
Before you start
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Down loading SX drivers from the Perle web site

You can install the SX driver and utility software from the Perle web site. To do this proceed 
as follows;

1. On your PC, start the Internet browser you want to use (for example, Netscape).

2. Within your Internet browser window, select the software directory using the following 
URLs;

http://www.perle.com/downloads 

3. Change to the software directory.

The software directory is now displayed.

4. Download the files in this directory to a suitable location on your PC for example, /tmp.

5. Follow the instructions for installing the software.

Note

In the event of any problems contact your System Administrator or 
Internet Service Provider for assistance.
SX User Guide 
Down loading SX drivers from the Perle web site
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Installing SX under Solaris

This section tells you how to install host cards, software drivers and utilities under the Solaris 
operating system and includes the following;

• General setup procedure for Solaris on page 29

• Installing device drivers and utilities on page 30

• Assigning ISA host card addresses and IRQ levels on page 31

• Removing SX drivers and utilities from your system on page 32

• Setting up terminals using Admintool on page 34

• Removing SX serial port terminals on page 38
SX User Guide 
Installing SX under Solaris
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General setup procedure for Solaris

The general procedure for installing SX for the Solaris operating system is as follows:

1. If required, install any PCI host cards you require into your system. See Installing a 
Universal 3.3/5V PCI host card on page 131

2. Install the SX Solaris drivers and utilities onto your system using the procedures 
described in Installing device drivers and utilities on page 30.

3. If are unable to find a free interrupt level for the card you are installing, you will need to 
enable polling mode using the sxiascfg utility (see sxisacfg utility on page 183 in 
Chapter 4 Quick reference). To do this; 

a. At the command prompt, type sxisacfg -l and press the Enter key to display the 
current polling mode.

b. If the system is in interrupt mode (default setting), at the command prompt type 
sxisacfg -p -l and press the Enter key to toggle into polled mode.

4. If required, using the sxisacfg utility, select and assign addresses for any additional ISA 
host cards you want to install from the free addresses available. See Assigning ISA host 
card addresses and IRQ levels on page 31.

5. If required, install any ISA host cards you require into your system. See Installing an ISA 
host card on page 133

6. If you want to remove any ISA host cards from your system,

a. at the command prompt, type:

/etc/sxisacfg [-d <name>] and press the Enter key 

where <name> is the host card name (for example, ISA1) and d is the delete com-
mand.

b. Now physically remove any host cards you want from your system using the 
procedures described in Removing host cards on page 135.

7. Install the device concentrators you require for your system. See Installing device 
concentrators on page 136.

8. If required, remove any device concentrators you want from your system. See Removing 
Device Concentrators from your system on page 149.

9. Set up any terminals attached to your system using Admintool. See Setting up terminals 
using Admintool on page 34.

10.If required, remove any terminals from your system using Admintool. See Removing SX 
serial port terminals on page 38.

11.If you want to use baud rates above 38400 use the spxbaudmap utility to obtain the 
values you want for each port. See Appendix B Obtaining baud rates above 38400.

Your system is now ready for use. If required, you can reconfigure the system following initial 
installation. See page 31 and page 34 for details.
SX User Guide 
Installing SX under Solaris
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Installing device drivers and utilities

To install the SX device drivers and utilities for the Solaris operating system proceed as 
follows;

1. Login to your system as super user and begin a terminal session.

2. At the command prompt, type one of the commands shown in the next table depending 
on the source of the sx-sol.pkg file you want to use, then press the Enter key.;

A series of message are now displayed ending with a question prompt:

3. At the question prompt, type Y and press the Enter key.

A series of messages are now displayed ending with a confirmation that installation was 
successful.

The drivers and utility software is now installed and operational. See General setup 
procedure for Solaris on page 29 for instructions on adding ISA host cards, Device 
Concentrators and Ports.

Note

Before you install the SX drivers and utilities you need to obtain the driver 
package file sx-sol-<ver>.pkg - “version”.pkg for example, sx-sol-1.1.2.pkg.

You can do this from either the CDROM (Solaris will automatically mount the 
CDROM when inserted, and start the file manager application), or the Perle 
website (see Down loading SX drivers from the Perle web site on 
page 27).

Source of sx-sol.pkg 
file Type this command

CDROM
Note x is version 
number

pkgadd -d /cdrom/drivers/sxplus/solaris/sx-sol-1.1.1.pkg
SX User Guide 
Installing SX under Solaris
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Assigning ISA host card addresses and IRQ levels

The sxisacfg Utility allows you to define addresses and IRQ levels for SX host cards you 
add to the system. You run this utility before installing the hardware using the following steps;

1. Decide on the name, memory address and IRQ level you require.

2. On each host card, set the address you want using the procedures described in 
Installing an ISA host card on page 133.

3. At the command prompt, enter the command to start the sxisacfg utility (see page 183 
for syntax) using the card parameters you decided in step 1. as shown in the next 
example:

/etc/sxisacfg -n ISA1 -m 0xD0000 -i 9

4. Press the Enter key.

5. Repeat steps 1. to 4. until you have assigned addresses to all the ISA host cards you 
want to install.

You can now continue with the rest of the procedure required to install the host card. See 
step 5. in General setup procedure for Solaris on page 29 for details. 

Note

You may need to reserve memory and Interrupt resources for ISA 
cards using the system BIOS setup or system configuration program.

Note

We recommend using interrupt mode, which is the default (toggled 
using the -p command).
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Removing SX drivers and utilities from your system

To remove the SX device drivers and utilities for the Solaris operating system, proceed as 
follows;

1. Login to your system as super user and begin a terminal session.

2. At the command prompt, type pkgrm sx-sol and press the Enter key.

The following question is displayed:

3. At the question prompt, type y and press the Enter key.

A further confirmation is displayed.

4. At the question prompt, type y and press the Enter key to remove the software package.

The messages shown in the next picture are now displayed and SX driver and utility software 
removed.
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Setting up terminals using Admintool

To configure SX serial ports added to the system proceed as follows;

1. In the Solaris desktop, single click on the Application Manager toolbar icon shown in the 
next picture.

The Application Manager window is now displayed.

2. In the Application Manager window, double click on the System_Admin folder.

The System_Admin window is now displayed.

3. In the System_Admin window, double click on the Admintool icon.

The main Admintool window is now displayed as shown in the next picture.

Double click here to start 
Application Manager.
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4. In the Admintool menu, click on Browse > Serial Ports. 

The Serial Ports window is now displayed.

5. In the Serial Ports window, double click on the serial port you want to modify. 
Alternatively, click on the port to highlight it, then in the Serial Ports menu click on 
Edit > Modify.

The Modify Serial Port window is now displayed.

6. In the Modify Serial Port window, display basic information only by clicking on the Basic 
button in the Detail field.
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7. In the Modify Serial Port window, click on the Template selector and choose the type of 
device you want to connect to the currently selected serial port. For example, to attach a 
terminal to the serial port, select Terminal-Hardwired.

8. In the Modify Serial Port window, click in the Service Enable checkbox (displaying a tick) 
to enable the currently selected serial port.

9. In the Modify Serial Port window, click on the Baud Rate selector and choose the Baud 
rate you want. For example, 9600.

10.In the Terminal Type field, enter the terminal type you want.

11.In the Modify Serial Port window, click on the OK 

The currently selected serial port now has a terminal session enabled at the specified baud 
rate, even parity, 7 data bits and 1 stop bit. The Serial Ports window is now updated to show 
this as shown in the next picture.

Hint

For details of the parameters in this field click on the help button to invoke the Solaris 
on-line help about this window.

Note

If you want to use baud rates above 38400, use the spxbaudmap utility to obtain the 
values you want for each port. See Appendix B Obtaining baud rates above 
38400. Note that the value you choose here is used to determine the 
extended baud rate.

Note

The terminal type you enter must be a valid terminal type as defined by the termcap file. 
See the Solaris user documentation or on-line help for further details.
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12.Repeat steps 5. to 11. until you have configured all the SX serial ports you require.
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Removing SX serial port terminals

To remove any SX serial ports configured as terminals proceed as follows;

1. In the Solaris desktop, single click on the Application Manager toolbar icon shown in the 
next picture.

The Application Manager window is now displayed.

2. In the Application Manager window, double click on the System_Admin folder.

The System_Admin window is now displayed.

3. In the System_Admin window, double click on the Admintool icon.

The main Admintool window is now displayed as shown in the next picture.

Double click here to start 
Application Manager.
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4. In the Admintool menu, click on Browse > Serial Ports 

The Admintool window is now updated to show the serial ports available on the system.

5. In the Admintool window, single click on the terminal you want to remove to highlight it.

6. In the Admintool menu, click on Select Edit > Delete.

The terminal entry for the serial port is now deleted and the Admintool window updated.

7. Repeat steps 5. to 6. until you have removed all the SX terminal entries you require.
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Installing SX under SCO OpenServer 5

This section tells you how to install host cards, software drivers and utilities under the SCO 
OpenServer 5 operating system and includes the following;

• General installation procedure for SCO OpenServer 5 on page 41

• Installing device drivers and utilities on page 42

• Assigning ISA host card addresses and IRQ levels on page 47

• Configuring SX serial ports on page 55

• Removing SX drivers and utilities from your system on page 60.
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General installation procedure for SCO OpenServer 5

The general procedure for installing and configuring host cards, drivers software and 
associated utilities for the SCO OpenServer 5 operating system is as follows:

1. If required, install any PCI host cards you require into your system. See Installing a 
Universal 3.3/5V PCI host card on page 131 

2. If required, install the SX SCO OpenServer 5 drivers and utilities onto your system using 
the procedures described in Installing device drivers and utilities on page 42.

3. If required, using the Host Card Configuration tool, select and assign addresses for any 
additional ISA host cards you want to install from the free addresses available. See 
Assigning ISA host card addresses and IRQ levels on page 47.

4. Repeat step 3. until you have assigned addresses to all the ISA host cards you want to 
install.

5. If required, install any ISA host cards you require into your system. See Installing an ISA 
host card on page 133

6. If required, remove any host cards you want from your system. See Removing host 
cards on page 135.

7. Install or remove any device concentrators you require onto your system. See Installing 
device concentrators on page 136 and Removing Device Concentrators from your 
system on page 149

8. Using the Port Configuration tool, configure the serial ports you have added to the 
system. See Configuring SX serial ports on page 55.

9. If you want to use baud rates above 38400 use the spxbaudmap utility to obtain the 
values you want for each port. See Appendix B Obtaining baud rates above 38400.

Your system can now use the serial adaptor cards you have installed. If required, you can 
reconfigure serial ports following initial installation. See Assigning ISA host card 
addresses and IRQ levels on page 47 and Configuring SX serial ports on page 55 for 
details.

Note

If you are installing a PCI card after having installed your driver, you will need to run the 
host card configuration utility to create the relevant device nodes. See Assigning ISA 
host card addresses and IRQ levels on page 47 and Appendix A Serial port 
device names.
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Installing device drivers and utilities

To install the SX device drivers and utilities for the SCO OpenServer 5 operating system 
proceed as follows;

1. Login to your system as super user.

2. Load the CDROM into your system CD drive.

3. At the command prompt, make a directory for your installation by typing:

mkdir /cdrom

4. Mount the CDROM file system using the following commands:

mount -f ISO9660 -r /dev/cd0 /cdrom 

5. In the SCO OpenServer 5 desktop, double click on the System Administration folder.

The System Administration window is now displayed.

6. In the System Administration window, double click on the Software Manager icon.

The Software Manager window is now displayed.

Note

The example above shows the directory name as /cdrom, You can either use this 
name or use another directory name to suit your requirements. For example, /mnt.
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7. In the Software Manager menu, click on Software > Install New.

The Begin Installation window is now displayed as shown in the next picture.

8. In the Begin Installation window, select the local host as the machine to install from by 
clicking on the From localhostname button and then click on Continue.

The Select Media window is now displayed.

9. In the Select Media window, using the Media Device selector choose the Media Images 
option then click on Continue.

The Enter Image Directory window is now displayed.

Click here to 
select the local 
host as the host 
machine. 
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10.In the Enter Image Directory window, enter the following in the Image directory field;

/cdrom/drivers/sx/openserver 

11.In the Enter Image Directory window, click on OK.

The Install Selection window is now displayed.

Note

The example and picture above show a directory name including /cdrom, You can 
either include this name in the path or use another directory name to suit your 
requirements. For example, /mnt.
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12.In the Install Selection window, click on the Install button.

The following progress message is now displayed.

13.During the driver installation, the host card configuration utility window displays as 
follows;

14.Using the Host Card Configuration utility, add any cards you want to the system then exit 
the utility and save changes. See Assigning ISA host card addresses and IRQ 
levels on page 47.

If you have re-linked the kernel earlier in this procedure, a message window is now 
displayed prompting you to re-boot the system.
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15.In the message window click on OK to continue the installation process.

The following message is now displayed upon completion of the installation process.

16.In the message window, click on OK to close the window.

The software manager window is now updated to show the driver you have installed as 
shown in the next picture.

17.In the Software Manager window, click on the Host > Exit menu option to close the 
window.

18.Shut down your system and turn the power off.

You can now continue with the rest of the installation process see General installation 
procedure for SCO OpenServer 5 on page 41.
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Assigning ISA host card addresses and IRQ levels

The Host Card Configuration Utility allows you to define and edit addresses and IRQ levels 
for SX host cards you add to the system. In addition this utility automatically creates and 
removes serial port device nodes.

This section includes the following;

• Starting the Host Card Configuration utility on page 48

• Adding a new host card address on page 50

• Editing a host card address on page 51

• Removing a host card address on page 53

• Exiting the Host Card Configuration utility on page 54

Note 

If you make any changes to the host card addresses on the system, 
you will need to restart the software kernel. See Re-building the 
kernel on page 54 for details.
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Starting the Host Card Configuration utility

You can start the Host Card Configuration utility in one of two ways;

• Using the command line. See page 48.

• Using the SCO OpenServer 5 desktop. See page 49.

Using the 
command line

To start the Host Card Configuration Utility from the command line proceed as follows;

1. At the command prompt, type siinit and press the Enter key. 

The Configuration window is now displayed.

You can now use the utility to add, remove or edit host card parameters.
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Using the SCO 
OpenServer 5 
desktop

To start the Host Card Configuration Utility from the SCO OpenServer 5 desktop proceed as 
follows;

1. In the SCO OpenServer 5 desktop, open the System Administration folder.

The System Administration window is now displayed.

2. In the System Administration window, click on the Specialix SX folder to open it.

The Specialix SX window is now displayed

3. In the Specialix SX window, click on the siinit Icon.

The Configuration window is now displayed.

You can now use the utility to add, remove or edit host card parameters.
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Adding a new host card address

In order to function, each ISA host card must be allocated an available I/O address and IRQ 
level. The Host Card Configuration utility allows you to determine the available addresses 
and IRQ levels, then allocate them to a particular host card. To do this proceed as follows;

1. In the Host Card Configuration menu, click on Card > Add.

The Set Address and IRQ window is now displayed which shows the next available host 
card address and IRQ level by default.

Selecting non-
default address 
and IRQ level

2. If you want to allocate an address and IRQ level other than the default proceed as follows;

a. In the Set Address and IRQ window, click in the Address (hex) field and enter the 
address you want in hexidecimal.

b. In the Set Address and IRQ window, click on the IRQ (Interrupt level ReQuest 
level) selector and select a free IRQ level.

Testing your 
selection

3. In the Set Address and IRQ window, click on the Check button to verify the values you 
have entered.

The Resource Check Result pop-up is now displayed telling you whether or not the 
selected address and IRQ level are valid. An example is shown in the next picture.
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4. In the pop-up, click on OK to close the window.

5. In the Host Card Configuration window click on OK to confirm your selection and close 
the window.

If your selection is invalid, the Resource Check Result pop-up message is now displayed. 
Otherwise, the address is now set and the host card configuration window updated to show 
the new card and address.

Editing a host card address

To edit an existing host card address on the system proceed as follows;

1. In the host card Configuration window, select the host card whose address you want to 
edit.
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2. In the Host Card Configuration menu, click on Card > Edit.

The Set Address and IRQ window is now displayed showing the current address and IRQ 
level for the selected host card.

3. In the Set Address and IRQ window click in the Address (hex) field and enter the 
address you want in hexidecimal.

4. In the Set Address and IRQ window, click on the IRQ (Interrupt level ReQuest level) 
selector and choose the IRQ level you want.

Testing your 
selection

5. If required, in the Set Address and IRQ window, click on the Check button.

The Resource Check result pop-up is now displayed telling you if the selected address 
and IRQ level are valid. An example is shown in the next picture.

6. In the pop-up, click on OK to close the window

7. In the Host Card Configuration window, click on OK to confirm any changes and close the 
window.

If your selection is invalid, the Resource Check Result pop-up message is now displayed. 
Otherwise, the new address is now set and the host card configuration window updated to 
show the changes.
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Removing a host card address

To remove a host card address from the system, proceed as follows;

1. In the host card configuration window, click on one or more of the host cards listed in the 
Current Host Card Configuration field highlighting them.

2. In the Host Card Configuration menu, click on Card > Remove.

The Host Card Configuration window is now updated to show the remaining host cards 
only.
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Exiting the Host Card Configuration utility

Quitting and saving To exit the Host Card Configuration utility and save any changes you have made, proceed as 
follows;

1. In the Host Card Configuration menu, click on Card > Save and exit.

Re-building the 
kernel

If you have made any changes a pop-up now appears prompting you to re-build the 
operating system kernel, otherwise the utility closes.

2. In the pop-up, click on the Yes button to re-link the operating system kernel.

The Kernel now re-links and a busy message is displayed during this process, followed by 
a confirmation pop-up.

3. In the confirmation pop-up, click on OK to close the window.

The Host Card Configuration utility now closes and saves any changes you have made.

Note

To quit the Host Card Configuration utility without saving any changes:

• In the In the Host Card Configuration menu, click on Card > Quit.
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Configuring SX serial ports

The Port Configuration utility allows you to configure the extra SX serial ports you have 
added to your system. To do this proceed as follows;

Starting the Port 
Configuration utility

1. In the command prompt, type slxcfg and press the Enter key. Alternatively use the SCO 
OpenServer 5 desktop as follows;

a. In the SCO OpenServer 5 desktop, open the System Administration folder.

The System Administration window is now displayed.

b. In the System Administration window, click on the Specialix Serial folder to open 
it.

The Specialix SX window is now displayed

c. In the Specialix SX window, click on the Serial Port Enable Icon.

The Serial Port Enable window is now displayed as shown in the next picture.

Note

If you want to perform transparent printing from any of the terminals attached to your 
system, you need to check the contents of the printcap.slx file to see if the terminal 
type you are using is supported. To do this proceed as follows;

1. Using a text editor, go to the /etc directory and open the file called 
printcap.slx

2. Check the contents of the printcap.slx file to see if the terminal type you are 
using is supported. See page 203 in Appendix C Transparent printing for 
the syntax of the entries in this file.

3. If the terminal type you are using is not supported, add an entry for the new 
terminal type (including the type, transparent print ON and transparent print 
OFF strings) to the printcap.slx file (page 203). See the user guide for your 
terminal for details of the entries required.

You can now configure the ports you want using the Port Configuration utility.
SX User Guide 
Installing SX under SCO OpenServer 5

Page 55

Chapter 2 Installing hardware and software



Select a getty 
definition 
here. 
page 57. Select a 

terminal type 
here.
See page 57.

Select one or more ports from this list.
See page 57.

Enables or 
disables flow 
control.
See page Enables or disables login.

See page 58.

Selects the system run level at which you 
can log into the currently selected ports.
See page 58.

Configures the selected 
port as a modem.
See page 58.

Configures the currently 
selected port as direct. That 
is, directly connected to a 
terminal with no modem in 
between.
See page 58.

Menus.
See page 185

Port 
statistics 
enabled

Port 
configured 
as a 
Modem

Port configured as Direct
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Selecting ports 2. In the Port Configuration window, select the ports you want you want to configure by 
clicking on one or more items in the list of ports (example in next picture).

Selecting a getty 
definition

3. In the Serial Port Enable window, select the getty definition you want by double clicking 
on an item in the gettydefs list.

The list of currently selected ports is now updated to show the new getty definition.

Selecting VT type 4. In the VT Type list, double click on the terminal type you want for the currently selected 
ports and then select the Change > VT Type menu option to confirm your selection. 

The list of ports is now updated to show the new terminal type.

Hint

To select multiple items which follow each other in the list, hold down the Shift key and 
click on all the items you want.

To select multiple items from anywhere in the list, hold down the Ctrl key and click on all 
the items you want.

Note

If you want to use baud rates above 38400, use the spxbaudmap utility to obtain the 
values you want for each port. See Appendix B Obtaining baud rates above 
38400. Note that the value you choose here is used to determine the 
extended baud rate.
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Enabling and 
disabling flow 
control

5. If required, in the Port Configuration window, click on the ixon button and then select the 
Change > ixon/ixany menu option to enable flow control for Transparent printing. 

6. If required, in the Serial Port Enable window, click on the ixany button and then select the 
Change > ixon/ixany menu option to enable sending of data on receipt of the next 
character (when flow control is enabled on the transparent print port).

Setting up a port 
login

7. In the Port Configuration window, click on one of the menu options shown in the next 
table to display the ports with the login status you want to change. For example, ports 
without logins enabled. 

These options allow you to filter on the type of ports you are looking for. This facility is 
helpful when you have a large number of ports installed.

8. If required, in the Port Configuration window, select the ports whose logins status you 
want to change, then click on one of the following to change the login status;

Note 

For information about transparent printing, see Appendix C Transparent printing.

To Display Click menu option

Ports configured as modems Show > Modems

Ports configured as direct Show > Direct

Unconfigured ports Show > Unconfigured

All ports Show > All

To... Click on ..

Enable logins for a port Enable button

Disable logins for a port Disable button

Configure ports to directly connect to a terminal Direct button

Configure ports as modem Modem button
SX User Guide 
Installing SX under SCO OpenServer 5

Page 58

Chapter 2 Installing hardware and software



The selected ports in the list are now updated with their new login status. If you change 
the login status for a port, a symbol is displayed along side the port as shown in the next 
picture.

9. In the in the Serial Port Enable window, set the system run level to 2 by clicking on the 2 
check box in the Run Levels field.

10.Repeat steps 2. to 9. until you have configured all the ports you want.

Exiting the Port 
Configuration tool

11.In the Port Configuration menu, click on Port > Save and exit.

The Port Configuration tool now closes and saves any changes you have made.

Port statistics enabled

Port configured as a Modem

Port configured as Direct

Note

The recommended setting for this parameter is 2. Do not use 
any other settings unless you have a specific reason for 
doing so.

Note

To quit the Port Configuration tool without saving changes,

• In the Port Configuration menu, click on Port > Quit.
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Removing SX drivers and utilities from your system

To remove the SX device drivers and utilities for the SCO OpenServer 5 operating system 
proceed as follows;

1. In the SCO OpenServer 5 desktop, double click on the System Administration folder.

The System Administration window is now displayed.

2. In the System Administration window, double click on the software manager icon.

The Software Manager window is now displayed.

3. In the Software Manager window select the driver you want to remove.

4. In the Software Manager menu, click on Software > Remove software.

A confirmation window is now displayed prompting you to confirm removal
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5. In the confirmation window, click on the Remove button.

The software is now removed and the following Kernel re-link message is now displayed 
as shown in the next picture.

The Kernel re-link message window now closes and the removal continues. A message is 
displayed upon completion.

6. In the message window, click on OK to close the window.

The software manager window is now updated to show the remaining software.
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Installing SX under SCO OpenServer 6

This section tells you how to install host cards, software drivers and utilities under the SCO 
OpenServer 6 operating system and includes the following;

• General installation procedure for SCO OpenServer 6 on page 63

• Installing device drivers and utilities on page 64

• Configuring SX serial ports on page 71

• Removing SX drivers and utilities from your system on page 76.
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General installation procedure for SCO OpenServer 6

The general procedure for installing and configuring host cards, drivers software and 
associated utilities for the SCO OpenServer 6 operating system is as follows:

1. If required, install any PCI host cards you require into your system. See Installing a 
Universal 3.3/5V PCI host card on page 131 

2. If required, install the SX SCO OpenServer 6 drivers and utilities onto your system using 
the procedures described in Installing device drivers and utilities on page 64.

3. If required, remove any host cards you want from your system. See Removing host 
cards on page 135.

4. Install or remove any device concentrators you require onto your system. See Installing 
device concentrators on page 136 and Removing Device Concentrators from your 
system on page 149

5. Using the Port Configuration tool, configure the serial ports you have added to the 
system. See Configuring SX serial ports on page 71.

6. If you want to use baud rates above 38400 use the spxbaudmap utility to obtain the 
values you want for each port. See Appendix B Obtaining baud rates above 38400.

Your system can now use the serial adaptor cards you have installed. If required, you can 
reconfigure serial ports following initial installation. See Starting the Host Card 
Configuration utility on page 69 and Configuring SX serial ports on page 71 for details.

Note

If you are installing a PCI card after having installed your driver, you will need to run the 
host card configuration utility to create the relevant device nodes. See Starting the 
Host Card Configuration utility on page 69 and Appendix A Serial port device 
names.
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Installing device drivers and utilities

To install the SX device drivers and utilities for the SCO OpenServer 6 operating system 
proceed as follows;

1. Login to your system as super user.

2. Load the CDROM into your system CD drive.

3. At the command prompt, make a directory for your installation by typing:

mkdir /cdrom

4. Mount the CDROM file system using the following commands:

mount -f ISO9660 -r /dev/cd0 /cdrom 

5. In the SCO OpenServer 6 desktop, double click on the Software Manager icon.

The Software Manager window is now displayed.

Note

The example above shows the directory name as /cdrom, You can either use this 
name or use another directory name to suit your requirements. For example, /mnt.
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6. In the Software Manager menu, click on Software > Install New.

The Begin Installation window is now displayed as shown in the next picture.

7. In the Begin Installation window, select the local host as the machine to install from by 
clicking on the From localhostname button and then click on Continue.

The Select Media window is now displayed.

8. In the Select Media window, using the Media Device selector choose the Media Images 
option then click on Continue.

The Enter Image Directory window is now displayed.

Click here to 
select the local 
host as the host 
machine. 
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9. In the Enter Image Directory window, enter the following in the Image directory field;

/cdrom/drivers/sx/openserver6 

10.In the Enter Image Directory window, click on OK.

The Install Selection window is now displayed.

11.In the Install Selection window, click on the Install button.

The following progress message is now displayed.

Note

The example and picture above show a directory name including /cdrom, You can 
either include this name in the path or use another directory name to suit your 
requirements. For example, /mnt.
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12.During the driver installation, the Host Card Configuration utility window displays as 
follows;

13.Use the Host Card Configuration utility to specify the total number of ports you have 
attached to your SX card(s), then exit the utility to save the changes.

If you change the number of ports, the kernel will be re-linked and a message window is 
displayed prompting you to re-boot the system.

14.In the message window click on OK to continue the installation process.

The following message is now displayed upon completion of the installation process.
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15.In the message window, click OK to close the window.

The software manager window is now updated to show the driver you have installed as 
shown in the next picture.

16.In the Software Manager window, click on the Host > Exit menu option to close the 
window.

17.Shut down your system and turn the power off.

You can now continue with the rest of the installation process see General installation 
procedure for SCO OpenServer 6 on page 63.
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Starting the Host Card Configuration utility

You can start the Host Card Configuration utility in one of two ways;

• Using the command line. See page 69.

• Using the SCO OpenServer 6 desktop. See page 70.

Using the 
command line

To start the Host Card Configuration Utility from the command line proceed as follows;

1. At the command prompt, type siinit and press the Enter key. 

The Configuration window is now displayed.

You can now use the utility to enter a new total number of attached serial ports.
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Using the SCO 
OpenServer 6 
desktop

To start the Host Card Configuration Utility from the SCO OpenServer 6 desktop proceed as 
follows;

1. In the SCO OpenServer 6 desktop, open the System Administration folder.

The System Administration window is now displayed.

2. In the System Administration window, click on the Perle-Serial folder to open it.

3. In the Perle-Serial window, click on the SX Hardware Configuration Icon.

The Configuration window is now displayed.

You can now use the utility to enter a new total number of attached serial ports.
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Exiting the Host Card Configuration utility

Quitting and saving To exit the Perle SX Configuration window and save any changes you have made, proceed 
as follows;

1. In the Perle SX Configuration window, click on Card > Exit.

If you have made any changes, the system files will be updated when the Perle SX 
Configuration window closes, saving any changes you made.

Configuring SX serial ports

The Port Configuration utility allows you to configure the extra SX serial ports you have 
added to your system. To do this proceed as follows;

Note

If you want to perform transparent printing from any of the terminals attached to your 
system, you need to check the contents of the printcap.si file to see if the terminal 
type you are using is supported. To do this proceed as follows;

1. Using a text editor, go to the /etc directory and open the file called printcap.si

2. Check the contents of the printcap.si file to see if the terminal type you are 
using is supported. See page 203 in Appendix C Transparent printing for 
the syntax of the entries in this file.

3. If the terminal type you are using is not supported, add an entry for the new 
terminal type (including the type, transparent print ON and transparent print 
OFF strings) to the printcap.si file (page 203). See the user guide for your 
terminal for details of the entries required.

You can now configure the ports you want using the Port Configuration utility.
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Starting the Port 
Configuration utility

1. At the command prompt, type sienable and press the Enter key. Alternatively use the 
SCO OpenServer 6 desktop as follows;

a. In the SCO OpenServer 6 desktop, open the System Administration folder.

The System Administration window is now displayed.

b. In the System Administration window, click on the Perle-Serial folder to open it.

c. In the Perle-Serial window, click on the SX Port Configuration Icon.

The Serial Port Enable window is now displayed as shown in the next picture.

Select a getty 
definition here. 
See page 73.

Select a 
terminal type 
here.
See page 73.

Select one or more ports from this list.
See page 73.

Enables or 
disables flow 
control.
See page 74. Enables or disables login.

See page 74.

Selects the system run level at which you 
can log into the currently selected ports.
See page 74.

Configures the selected 
port as a modem.
See page 74.

Configures the currently 
selected port as direct. That 
is, directly connected to a 
terminal with no modem in 
between.
See page 74.

Menus.
See page 185

Port 
configured 
as a 
Modem

Port configured as Direct
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Selecting ports 2. In the SX Port Configuration window, select the ports you want to configure by clicking on 
one or more items in the list of ports (example in next picture).

Selecting a getty 
definition

3. In the SX Port Configuration window, select the getty definition you want by double 
clicking on an item in the gettydefs list.

The list of currently selected ports is now updated to show the new getty definition.

Selecting VT type 4. In the VT Type list, double click on the terminal type you want for the currently selected 
ports and then select the Change > VT Type menu option to confirm your selection. 

The list of ports is now updated to show the new terminal type.

Hint

To select multiple items which follow each other in the list, hold down the Shift key and 
click on all the items you want.

To select multiple items from anywhere in the list, hold down the Ctrl key and click on all 
the items you want.

Note

If you want to use baud rates above 38400, use the spxbaudmap utility to obtain the 
values you want for each port. See Appendix B Obtaining baud rates above 
38400. Note that the value you choose here is used to determine the 
extended baud rate.
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Enabling and 
disabling flow 
control

5. If required, in the SX Port Configuration window, click on the ixon button and then select 
the Change > ixon/ixany menu option to enable flow control for Transparent printing. 

6. If required, in the SX Port Configuration window, click on the ixany button and then select 
the Change > ixon/ixany menu option to enable sending of data on receipt of the next 
character (when flow control is enabled on the transparent print port).

Setting up a port 
login

7. In the SX Port Configuration window, click on one of the menu options shown in the next 
table to display the ports with the login status you want to change. For example, ports 
without logins enabled. 

These options allow you to filter on the type of ports you are looking for. This facility is 
helpful when you have a large number of ports installed.

8. If required, in the SX Port Configuration window, select the ports whose logins status you 
want to change, then click on one of the following to change the login status;

The selected ports in the list are now updated with their new login status. If you change 
the login status for a port, a symbol is displayed along side the port as shown in the next 
picture.

Note 

For information about transparent printing, see Appendix C Transparent printing.

To Display Click menu option

Ports configured as modems Show > Modems

Ports configured as direct Show > Direct

Unconfigured ports Show > Unconfigured

All ports Show > All

To... Click on ..

Disable logins for a port Disable button

Configure ports to directly connect to a terminal Direct button

Configure ports as modem Modem button

NOTE: If you already have a getty running against the port, you need 
to disable the port and then enable the port to make the change take 
effect.
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9. In the in the SX Port Configuration window, set the system run level to 2 by clicking on the 
2 check box in the Run Levels field.

10.Repeat steps 2. to 9. until you have configured all the ports you want.

Exiting the Port 
Configuration tool

11.In the SX Port Configuration menu, click on Show > Exit.

The SX Port Configuration tool now closes and saves any changes you have made.

Port configured as a Modem

Port configured as Direct

Note

The recommended setting for this parameter is 2. Do not use 
any other settings unless you have a specific reason for 
doing so.
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Removing SX drivers and utilities from your system

To remove the SX device drivers and utilities for the SCO OpenServer 6 operating system 
proceed as follows;

1. In the SCO OpenServer 6 desktop, double click on the Software Manager icon.

The Software Manager window is now displayed.

2. In the Software Manager window select the driver you want to remove.

3. In the Software Manager menu, click on Software > Remove software.

A confirmation window is now displayed prompting you to confirm removal

4. In the confirmation window, click on the Remove button.

The software is now removed and the following Kernel re-link message is now displayed 
as shown in the next picture.
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The Kernel re-link message window now closes and the removal continues. A message is 
displayed upon completion.

5. In the message window, click on OK to close the window.

The software manager window is now updated to show the remaining software.
SX User Guide 
Installing SX under SCO OpenServer 6

Page 77

Chapter 2 Installing hardware and software



Installing SX under SCO UnixWare

This section tells you how to install host cards, software drivers and utilities under the SCO 
UnixWare operating system and includes the following;

• General installation procedure for SCO UnixWare on page 79

• Upgrading from existing device drivers on page 80

• Installing drivers and utilities onto your system on page 81

• Assigning ISA host card addresses and IRQ levels on page 85

• Configuring serial ports on page 95

• Configuring serial ports under SCO UnixWare 2 on page 100

• Adding new ports on page 102

• Removing SX drivers and utilities from your system on page 104.

Note

When using SX PCI host cards, you will require SX SCO UnixWare driver v3.1.0 
or later. You can find this driver on the CDROM supplied with this product or on our 
website at http://www.perle.com
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General installation procedure for SCO UnixWare

The general procedure for installing and configuring host cards, drivers software and 
associated utilities for the SCO UnixWare operating system is as follows:

1. Install any PCI host cards you require into your system. See Installing a Universal 3.3/
5V PCI host card on page 131 

2. If required, install the SX SCO UnixWare drivers and utilities onto your system using the 
procedures described in Installing drivers and utilities onto your system on page 81.

3. If required, using the UnixWare Device Configuration Utility, select and assign 
addresses for any additional ISA host cards you want to install from the free addresses 
available. See Assigning ISA host card addresses and IRQ levels on page 85.

4. Repeat step 3. until you have assigned addresses to all the ISA host cards you want to 
install.

5. If required, install any ISA host cards you require into your system. See Installing an ISA 
host card on page 133

6. If required, remove any host cards you want from your system. See Removing host 
cards on page 135.

7. Install or remove any device concentrators you require onto your system. See Installing 
device concentrators on page 136 and Removing Device Concentrators from your 
system on page 149

8. Using the Serial Manager utility, configure the serial ports you have added to the system. 
See Configuring serial ports on page 95.

9. If you are adding more than 32 ports to your system, add the extra ports to your system 
using the procedures described in Adding new ports on page 102.

10.If you want to use baud rates above 38400 use the spxbaudmap utility to obtain the 
values you want for each port. See Appendix B Obtaining baud rates above 38400.

Your system can now use the serial adaptor cards you have installed. If required, you can 
reconfigure serial ports following initial installation. See Assigning ISA host card 
addresses and IRQ levels on page 85 and Configuring serial ports on page 95 for 
details.

Note 

If you are running version 2 of the SCO UnixWare operating system you need to use the 
procedures described in Configuring serial ports under SCO UnixWare 2 on page 100.
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Upgrading from existing device drivers

If your system already has an existing Perle device driver installed, you cannot install a new 
device driver unless you follow the correct upgrade procedure. The procedure required 
depends on the device driver type currently installed as follows;

• Upgrading from Specialix SI/XIO Svr4 driver v7.01 on page 80

• Upgrading from SLXOS SCO UnixWare driver v2.1.0 on page 80

• Upgrading from SX SCO UnixWare Driver v3.0.x on page 80

Upgrading from Specialix SI/XIO Svr4 driver v7.01

You cannot upgrade the Specialix SX SI/XIO Svr4 driver v7.01. You need to remove the old 
driver, then install its replacement as follows;

1. Remove the existing device driver using the pkrm slx command. See also Removing SX 
drivers and utilities from your system on page 104.

2. Install the new device driver using the procedures described in Installing drivers and 
utilities onto your system on page 81.

3. Continue with your installation as required using the steps listed under General 
installation procedure for SCO UnixWare on page 79.

Upgrading from SLXOS SCO UnixWare driver v2.1.0

You cannot upgrade the Specialix SLXOS SCO UnixWare driver v2.1.0. You need to remove 
the old driver, then install its replacement as follows;

1. Remove the existing device driver using the pkrm slx command. See also Removing SX 
drivers and utilities from your system on page 104.

2. Install the new device driver using the procedures described in Installing drivers and 
utilities onto your system on page 81.

3. Continue with your installation as required using the steps listed under General 
installation procedure for SCO UnixWare on page 79.

Upgrading from SX SCO UnixWare Driver v3.0.x

When you can upgrade SX drivers, you do not have to remove the previously installed driver. 
Simply install the driver using the procedures given in Installing drivers and utilities onto 
your system on page 81.
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Installing drivers and utilities onto your system

To install the SX device drivers and utilities for the SCO UnixWare operating system proceed 
as follows;

1. Login to your system as super user.

2. Load the CDROM into your system CD drive.

3. At the command prompt, type scoadmin.

The System Administration window is now displayed.

4. In the System Administration window, double click on the Filesystem Manager folder.

The Filesystem Manager window is now displayed as shown in the next picture.

Note

When using SX PCI host cards, you will require SX SCO UnixWare driver v3.1.0 
or later. You can find this driver on the CDROM supplied with this product..
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5. In the Filesystem Manager menu, click on Mount > Add Mount Configuration >Local.

The Add Local Mount Configuration window is now displayed.
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6. In the Add Local Mount Configuration window, set only the options detailed in the next 
table:

7. In the Add Local Mount Configuration window, click on OK to accept the settings and 
close the window.

The Filesystem Manager window is now updated to show the new mount as shown in the 
next picture.

8. Filesystem Manager menu, click on Host > Exit to close the window.

Option Set to or enter....

Device File Select cdrom or string 
containing cdrom

Mount Point /cdrom

Access Mode Select Read-only

When to Mount Enable Now

Disable At System Startup

Hint

Experienced users can mount the CDROM directly by using the mount 
command. 

For example;

mount -r -Fcdfs -0 nmconv=c /dev/cdrom/c1b0t0l0/cdrom
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9. At the command prompt, type:
pkgadd -d /cdrom/drivers/sx/unixware/flopdisk.dd 

10.Press the Enter key. 

The system now installs the driver and displays a series of messages ending with an 
installation successful message and prompt.

11.At the prompt type q and press the Enter key.

12.At the command prompt, type shutdown -y -i6 and press the Enter key to shutdown and 
re-boot your system.

Upon completion of the system re-boot the SX drivers you have installed are ready to use.
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Assigning ISA host card addresses and IRQ levels

The Unixware Device Configuration Utility allows you to define and edit addresses and IRQ 
levels for SX host cards you add to the system. 

This section includes the following;

• Starting the Unixware Device Configuration Utility on page 86

• Adding a new host card address on page 88

• Editing a host card address on page 91

• De-activating a host card on page 92

• Exiting the Device Configuration Utility on page 94
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Starting the Unixware Device Configuration Utility

UnixWare provides a mechanism for adding and removing device hardware with the Device 
Configuration Utility. You will need to use this utility in order to add any ISA cards to your 
configuration.

You can start the Device Configuration Utility using either the command prompt or the SCO 
UnixWare System Administration tool. See the following;

• Command prompt method on page 86

• System Administration tool method on page 87.

Command prompt 
method

To start the Device Configuration Utility from the command prompt, proceed as follows;

• At the command prompt, type dcu and press the Enter key.

The Unixware Device Configuration Utility window is now displayed.

You can now use the Device Configuration Utility to configure or display host card 
addresses and IRQ levels. See Adding a new host card address on page 88.

Note

SX PCI cards are automatically deleted by the operating system. You 
do not need to add them manually.
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System 
Administration tool 
method

To start the Device Configuration Utility from the SCO UnixWare System Administration tool, 
proceed as follows;

1. At the command prompt, type scoadmin

The System Administration window is now displayed

2. In the System Administration tool window, click on the Hardware folder and then select 
Device Configuration Utility (DCU) 

The Unixware Device Configuration Utility window is now displayed.

You can now use the Device Configuration Utility to configure or display host card 
addresses and IRQ levels. See Adding a new host card address on page 88.
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Adding a new host card address

In order to function, each ISA host card must be allocated an available I/O address and IRQ 
level. The Device Configuration Utility allows you to determine the available addresses and 
IRQ levels, then allocate them to a particular host card. To do this proceed as follows;

1. Start the Unixware Device Configuration Utility. See Starting the Unixware Device 
Configuration Utility on page 86.

2. In the Device Configuration Utility Main Menu, click on Software Device Drivers.

The Software Device Driver Selections window is now displayed.

3. In the Software Device Driver Selections window, select Communications cards using 
the up and down arrow keys and press the Enter key to confirm your selection.

The Software Device Drivers window is now displayed as shown in the next picture.
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4. In the Software Device Drivers window, select the host card you want using the up and 
down arrow keys and then press the space bar to activate the card (denoted by a star 
symbol).

5. Press the F5 key.

The New Hardware Configuration window is now displayed.

6. In the New Hardware Configuration window, select IRQ using the up and down arrow 
keys and type in the new IRQ value you want to assign for the selected host card.

7. Repeat step 6. to set the upper and lower address values MemStart and MemEnd. Use 
the same procedure to set IOStart and IOEnd to - so they are not used.

8. Repeat steps 4. to 7. until you have set all the IRQ levels and addresses for all the host 
cards you require.

Note

SX allows you to run in polled mode. That is, to run without needing interrupts. This facility 
is useful when the normal interrupt levels used by SX are not available or you have 
a larger number of host cards the available interrupt levels. 

To set the host card to polled mode, set the IRQ field to -.

Note 

The Host card address values you enter must match the corresponding settings on the 
host cards. To set the address on ISA host cards, see Installing an ISA host card on 
page 133.
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9. Press the F10 key to accept the new values and close the window.

10.In the Software drivers window, press the Enter key

The Software drivers window now closes and the Device Configuration Utility window is 
now displayed.

11.In the Device Configuration Utility window, select the Return to DCU Main Menu option

12.The Device Configuration Utility Main Menu is now displayed.

13.In the Device Configuration Main Menu, select the Apply Changes & Exit DCU option.

Your changes are now saved and the Device Configuration Utility window now closes.
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Editing a host card address

The Device Configuration Utility allows you to edit existing host card addresses and IRQ 
levels. To do this proceed as follows;

1. Start the Unixware Device Configuration Utility. See Starting the Unixware Device 
Configuration Utility on page 86.

2. In the Device Configuration Utility Main Menu, click on Hardware Device Configuration.

The Hardware Device Configuration window is now displayed.

3. In the Hardware Device Configuration window, use the tab key move the cursor to the 
host card IRQ or address you wish to change.

4. At the selected location, type in the new IRQ or address value you want to assign for the 
selected host card (See also Installing an ISA host card on page 133).

5. Repeat steps 3. to 4. until you have set all the IRQ levels and addresses you require.

6. Press the F10 key to confirm your changes and close the window.

Note

You can only edit ISA card properties. PCI card properties are set by the 
operating system and cannot be changed by the user.

Activate (Y) or de-
activates (N) a host card. Enter IRQ (Interrupt 

request level) here

 Enter 
address of 
ISA host 
cards here

Not used 
for SX

Not used 
for SX
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De-activating a host card

To deactivate an installed host card proceed as follows;

1. Start the Unixware Device Configuration Utility. See Starting the Unixware Device 
Configuration Utility on page 86.

2. In the Device Configuration Utility Main Menu, click on Hardware Device Configuration

The Hardware Device Configuration window is now displayed.

3. In the Hardware Device Configuration window, use the tab key to move the cursor to the 
activate/deactivate field for the host card you want as shown in the next picture.

4. At the selected field type N to de-activate the host card (to re-activate type Y).

5. Repeat steps 3. to 4. until you have set all the IRQ levels and addresses you require.

6. Press the F10 key to accept the new values and close the window.

Activate (Y) or de-
activates (N) a host card. Enter IRQ (Interrupt 

request level) here

 Enter 
address of 
ISA host 
cards here

Not used 
for SX

Not used 
for SX

Type N here to de-
activate a host card.
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Displaying software device driver details

To display details of the software device drivers present on your system proceed as follows;

1. Start the Unixware Device Configuration Utility. See Starting the Unixware Device 
Configuration Utility on page 86.

2. In the Device Configuration Utility Main Menu, click on Hardware Device Configuration.

The Hardware Device Configuration window is now displayed showing details of the 
software device drivers present on your system.

3. Press the F10 key to confirm your changes and close the window.
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Exiting the Device Configuration Utility

Quitting and saving To exit the Device Configuration Utility and save any changes you have made, proceed as 
follows;

1. In the Device Configuration Utility Main Menu, click on Apply Changes & Exit DCU.

The Device Configuration Utility now closes and saves any changes you have made.

Note

To quit the Host Card Configuration utility without saving any changes:

• In the In the Host Card Configuration menu, click on Exit DCU and Cancel 
Changes.

Note

In most cases the kernel will need to be rebuilt in order for the changes to take 
effect to do this proceed as follows;

1. Login to your system as super user.

2. At the command prompt, type /etc/conf/bin/idbuild and press the Enter 
key.

You are now prompted to re-boot the system.

3. At the command prompt, type Shutdown -i6 -y to re-boot the system.

The system now re-boots displaying messages as it does so.
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Configuring serial ports

The SCO UnixWare 7 operating system includes a utility called Serial Manager which allows 
you to configure the extra SX serial ports you have added to your system. 

To configure serial ports with Serial Manager proceed as follows;

1. At the command prompt, type scoadmin

The System Administration window is now displayed as shown in the next picture.

Note 

If you are running version 2 of the SCO UnixWare operating system you need to use the 
procedures described in Configuring serial ports under SCO UnixWare 2 on page 100 
to configure your serial ports.

Note

On UnixWare 7.0, you must apply a patch file called ptf7053 before using the Serial Manager. 
You can find the patch on the SCO web site at;

http://www.sco.com 

Note

If you want to perform transparent printing from any of the terminals attached to your 
system, you need to check the contents of the printcap.slx file to see if the terminal 
type you are using is supported. To do this proceed as follows;

1. Using a text editor, go to the /etc directory and open the file called 
printcap.slx

2. Check the contents of the printcap.slx file to see if the terminal type you are 
using is supported. See page 203 in Appendix C Transparent printing for 
the syntax of the entries in this file.

3. If the terminal type you are using is not supported, add an entry for the new 
terminal type (including the type, transparent print ON and transparent print 
OFF strings) to the printcap.slx file (page 203). See the user guide for your 
terminal for details of the entries required.

4. If you have made any changes then either re-boot using by typing 
Shutdown -i6 -y or type slxcfg in order to re-configure the print port settings.

You can now configure the ports you want using the Serial Manager utility.
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2. In the System Administration tool window, click on the Hardware folder and then select 
Serial Manager

The Serial Manager window is now displayed showing the host cards (including SX) 
currently present on the system.

3. In the Serial Manager window, select the host card you want. Then in the Serial Manager 
menu, click on View > Ports .

The Serial Manager window now displays the ports available for the selected host card as 
shown in the next picture.
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4. In the Serial Manager menu, click on Port > Modify .
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The Modify Serial Port window is now displayed.

5. In the Modify Serial Port window, set the parameters shown in the next table

Parameter Set to

Port Type No change, should already be 
set to software flow control

Configure port incoming only

Speed the speed value you require

Note

If you want to use baud rates above 38400, use the spxbaudmap utility to obtain the 
values you want for each port. See Appendix B Obtaining baud rates above 
38400. Note that the value you choose here is used to determine the 
extended baud rate.
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6. In the Modify Serial Port window, click on the Port settings button.

The Port settings window is now displayed.

7. In the Port settings window, select the Data bits and Parity values you require and click 
on OK.

8. In the Modify Serial Port window, click on OK to accept the changes you have made and 
close the window.

9. Repeat steps 3. to 8. until you have configured the serial ports for all the host cards you 
require.

10.In the Serial Manager menu click on Host > Quit to quit Serial Manager and close the 
window.
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Configuring serial ports under SCO UnixWare 2

spxadmport SCO UnixWare 2 does not include the graphical user interface based Serial Manager utility. 
If you are running SCO UnixWare 2 on your computer, you need to run the spxadmport 
script from the command line to configure SX serial ports. You use this by typing a single line 
command which contains the information required for a given configuration task using the 
following syntax;

Syntax /etc/spxadmport command svctag [label] [owner]

where;

Procedure To use the spxadmport script to configure your SX serial ports proceed as follows;

1. At the command prompt, type one of the commands detailed in the next table using the 
following syntax;

/etc/spxadmport [command] [svctag] [label] [owner]

Item Description Example

command add, enable, disable, remove or list. remove

svctag device number from /dev/term. i01

label /etc/ttydefs entry (optional). 9600

owner user ID assigned to the port (optional). root

Command Description Example command

Add Adds a serial port to the 
service monitor (sxmon) and 
enables the port for monitoring 
logins.

/etc/spxadmport add d1 9600 root 

Enable Enables a previously disabled 
port for monitoring.

/etc/spxadmport enable

Disable Disables a port. Has the effect 
of disabling all further logins on 
this port.

/etc/spxadmport disable A1 

Remove Removes the selected serial 
port from the service monitor 
(sxmon).

/etc/spxadmport remove A2 

List Lists the currently defined 
services and/or port monitors.

/etc/spxadmport list 

List p Lists all logins configured. /etc/spxadmport list p

List s Lists all port services 
configured.

/etc/spxadmport list s 
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2. Press the Enter key.

The revised SX port configuration is now adopted by the system.
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Adding new ports

When you install an SX driver under the SCO UnixWare operating system, 32 ports are created by 
default. If you want to add more than 32 ports to your system (typically, when you want to add 
more Device Concentrators or Terminal adaptors to your system), you need to use the 
Configuration Administration utility to add more ports.

To add more ports proceed as follows;

1. At the command prompt, type slxadm and press the Enter key.

The Configuration Administration window is now displayed showing the TOP MENU 
options.

2. In the Configuration Administration window TOP MENU select the Adaptors option and 
press Enter to display the SX Adaptor configuration sub menu as shown in the next 
picture.

Note

If your system contains a mixture of TA4s and TA8s, then repeat steps 4. to 5. to enter 
and save the values for Adaptor size and Number of adaptors for each type of 
terminal adaptor separately.
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3. In the SX Terminal Adaptor submenu, select the Add option to display the 
Add SX Terminal Adaptor submenu.

4. In the Add SX Terminal Adaptor submenu, use the up and down arrow keys to move the 
cursor to each of the fields shown in the next table, then type in the new value. 

5. Press the F3 key to save your changes 

6. Press the F6 key to return to the TOP MENU. Then in the TOP MENU, select the Quit 
option and press the Enter key.

The Configuration Administration window now closes and you are returned to the command 
prompt.

Note

If your system contains a mixture of TA4s and TA8s, then repeat steps 4. to 5. to enter 
and save the values for Adaptor size and Number of adaptors for each type of 
terminal adaptor separately.

In this field Enter this information..

Adaptor size Enter the number of ports for the device concentrators or 
terminal adaptors type you are adding to the system. 
For example, for a TA8 enter 8.

Number of Adaptors Enter the number of device concentrators or terminal 
adaptors of this type in your system.
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Removing SX drivers and utilities from your system

To remove the software drivers from your system under the SCO UnixWare operating 
system proceed as follows;

1. At the command prompt, type pkgrm slxos and press Enter 

The SX driver and associated utilities are now removed from your system.

Note

Before removing a software driver you should first de-activate all SX host cards 
present on the system. See De-activating a host card on page 92.
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Installing SX under Windows NT

This section describes how to install the SX device driver software under Microsoft Windows 
NT.

General setup procedure for Windows NT

The general procedure for installing SX under the Windows NT operating system is as 
follows;

1. Install the PortDirector software onto your system using the procedures described in 
Chapter 2 Installing and removing PortDirector in the PortDirector User guide

2. Install or remove any PCI host cards you require on your system. See Installing a 
Universal 3.3/5V PCI host card on page 131 and Removing host cards on page 135.

3. Install or remove any ISA host cards you require on your system. See Installing an ISA 
host card on page 133 and Removing host cards on page 135.

4. Install or remove any device concentrators you require onto your system. See Installing 
device concentrators on page 136 and Removing Device Concentrators from your 
system on page 149

5. Update your system to include the new host cards or device concentrators you have 
added or removed from your system. See Chapter 5 Adding and deleting host cards in 
the PortDirector User guide.

6. Configure the ports you require using the procedures described in Chapter 6 Working 
with com ports of the PortDirector User guide.

Your system is now ready for use. If required you can reconfigure the system following initial 
installation. See Chapter 5 Adding and deleting host cards and Chapter 6 Working with 
com ports in the PortDirector User guide for further details.

Note

When using SX PCI host cards, you will require the PortDirector software version 
1.1.1(or later). 

You can find the PortDirector software on the CDROM supplied with this product or 
on our website at http://www.perle.com 

Note

A device driver is installed with the PortDirector software, included on the CDROM 
supplied with this product. See the PortDirector User guide for further details.
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Installing SX PCI host cards under Windows 2000/XP/
Server 2003/Vista/Server 2008

This section describes how to install SX PCI host cards under Microsoft Windows 2000/XP/
Server 2003/Vista/Server 2008.

This section includes the following;

• General setup procedure for Windows 2000/XP/Server 2003/Vista/Server 2008 on 
page 107

• Installing PCI host card device drivers and utilities onto your system on page 108

• Viewing and changing the resources for a device on page 118

• Configuring PCI host card serial ports on page 110.

Note

Whenever you add any SX or SI/XIO hardware to your system, by default Windows 2000 
will use its latest digitally signed driver in its driver database. To ensure you install the 
latest driver, run update.exe in the driver folder to ensure that every device currently 
installed in the system will use the latest driver.

Note

When using SX PCI host cards, you will require version 1.1.0 (or later) of the 
SX driver  for  Windows  2000/XP/Server 2003/Vista/Server 2008. 

You can find this version of the driver on the CDROM supplied with this product or on 
our website at http://www.perle.com.
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General setup procedure for Windows 2000/XP/Server 2003/Vista/Server 2008

The general procedure for installing the SX PCI host card under the Windows 2000/XP/
Server 2003/Vista/Server 2008 operating system is as follows:

1. Install or remove any PCI host cards you require on your system. See Installing a 
Universal 3.3/5V PCI host card on page 131 and Removing host cards on page 135.

2. Install or remove any device concentrators you require onto your system. See Installing 
device concentrators on page 136 and Removing Device Concentrators from your 
system on page 149.

3. Install the SX device driver software. See Installing PCI host card device drivers and 
utilities onto your system on page 108.

4. Using the Windows Device Manager, configure the serial ports you have added to the 
system. See Configuring PCI host card serial ports on page 110.

Note

The PCI host card and concentrator must be installed before you install 
the device drivers.
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Installing PCI host card device drivers and utilities onto your system

To install or enable the SX device drivers on your system proceed as follows:

1. Turn on your PC and if required, log in.

If you have installed any new host cards a Found New Hardware message is briefly 
shown followed by the Found New Hardware wizard as shown in the next picture.

2. In the Found New Hardware wizard, click the Cancel button.

3. Download the lastest SX driver zip file from the Perle website for your operating system:

sx-x86.zip for 32-bit Windows operating systems.

sx-amd64.zip for 64-bit Windows operating systems.

sx-ia64.zip for 64-bit Windows Itanium operating systems.

4. Unzip the driver zip file to a local directory. We recommend that you use the 
sx-setup-<arch>.exe file when installing the drivers for a SX PCI card, which will launch 
the installation wizard, to install the SX driver. 
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5. Double-click the sx-setup-<arch>.exe installation executable and follow the installation 
wizard steps:

6. During the installation, you may get a Windows Logo message. Click Continue Anyway 
when these appear.

7. Your SX driver installation is now finished.

8. To verify that you have the latest driver installed, select Start > All Programs > Perle > 
SX > Update Driver.

Note

If you are installing an unsigned driver, you may have to click through the Found New 
Hardware wizard for every SX card on your system.
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Configuring PCI host card serial ports

To configure SX serial ports under Windows, proceed as follows:

1. In the Windows desktop, click on the Start button and select Settings > Control Panel

The control panel window is now displayed.

2. In the Control Panel window, click on the System icon.

The System Properties tabbed window is now displayed.

3. In the System Properties window, click on the Hardware tab.

The hardware page is now displayed.

4. In the Hardware page, click on the Device Manager Button.

The Device Manager window is now displayed.
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5. In the Device Manager window, click on the Multiport serial adapters icon to display the 
currently installed devices.

6. In the Device Manager window, double click on the device whose properties you want to 
view or change.

The device Properties tabbed window is now displayed.

7. In the device Properties window, click on the Port Settings tab to display the Port 
Settings page.

8. In the Port Settings page, set the Port Number, Baud Rate and other configuration 
parameters you require and then click on the OK button to save changes and close the 
window.

The configuration process is now complete.
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Installing SX ISA host cards under Windows 2000

This section describes how to install SX ISA host cards under Microsoft Windows 2000.

This section includes the following:

• General ISA host card setup procedure for Windows 2000 on page 113.

• Adding ISA host cards to the system on page 114.

• Viewing and changing the resources for a device on page 118.

• Configuring serial ports on page 121.

Note

Whenever you add any SX or SI/XIO hardware to your system, by default Windows 2000 
will use its latest digitally signed driver in its driver database. To ensure you install the 
latest driver, run update.exe in the driver folder to ensure that every device currently 
installed in the system will use the latest driver. 

Note

The ISA host card and concentrator must be installed before you install 
the device drivers.

Note

You can find this version of the driver on the CDROM supplied with this product or on 
our website at http://www.perle.com 
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General ISA host card setup procedure for Windows 2000

The general procedure for installing SX ISA host cards under the Windows 2000 operating 
system is as follows:

1. If required, install any ISA host cards you require into your system. See Installing an ISA 
host card on page 133.

2. Install or remove any device concentrators you require onto your system. See Installing 
device concentrators on page 136 and Removing Device Concentrators from your 
system on page 149. 

3. If required, using the Windows 2000 Add/Remove Hardware wizard, add any additional 
ISA host cards to the list of installed devices on the system using the free addresses 
available. See Adding ISA host cards to the system on page 114.

4. Using the Windows 2000 Device Manager, configure the serial ports you have added to 
the system. See Configuring serial ports on page 121.

5. If required, remove any host cards you want from your system. See Removing host 
cards on page 135.

Note

You can find device driver on the CDROM supplied with this product or on our website at 
http://www.perle.com.
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Adding ISA host cards to the system

When you physically install an ISA host card in your system you also need to add the card to 
the list of installed devices in the system.

To add ISA host cards to your system proceed as follows:

1. Download the lastest SXdriver zip file, sx-x86.zip, from the Perle website.

for 32-bit Windows 2000, XP, Server 2003, Vista, or Server 2008 operating system.

2. Unzip the driver zip file to a local directory. 

3. In the Windows desktop, click on the Start button and select Settings > Control Panel.

The control panel window is now displayed.

4. In the control panel window, double click on the System icon.

The Add/Remove Hardware Wizard is now displayed.

Note

The addresses used by SX host cards are normally set by default. This 
procedure is used when you wish to set non-standard addresses.
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5. Using the instructions given in the next table, use the Add/Remove Hardware Wizard to 
assign the host card addresses and IRQ levels you require.

In this Wizard page Do the following...

6. In the Add/Remove Hardware Wizard, select 
Add/Troubleshoot a device and press the 
Next > button.

The Choose a Hardware Device page is now 
displayed. 

7. In the Choose a Hardware Device page, 
scroll up the list of devices and click on 
Add a new device, then click on the Next > 
button. 

The Find New Hardware page is now 
displayed.

8. In the Find New Hardware page, select No, I 
want to select the hardware from a list 
and click on the Next > button.

The Hardware Type page is now displayed.

9. In the Hardware Type page, select Mutli-
port serial adaptors and click on the Next > 
button.
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The Select a Device Driver page is now 
displayed.

10.If your host card type isn’t shown, in the 
Select a Device Driver page click on the 
Have Disk button.

A message window is now displayed which 
prompts you for the driver and location you 
want to use.

11. In the message window, enter or select the 
driver you want and click on the OK button to 
accept settings and close the window.

The Select a Device Driver page is now 
updated to show the new driver you have 
selected.

12.In the Select a Device Driver page, select 
the manufacturer and model you require, 
then click on the Next > button.

The Start Hardware Installation page is now 
displayed.

13.In the Start Hardware Installation page, click 
on the Next > button to accept your choice.

A completion message page is now 
displayed as shown in the next picture

Note

If resources are not free you will have to change the resource 
configuration using the procedures described on page 118.

In this Wizard page Do the following...
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14.In the completion message page click on the Finish button to complete the new 
configuration.

Note

To ensure you install the latest driver, run update.exe in the driver folder to ensure that 
every device currently installed in the system will use the latest driver. 
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Viewing and changing the resources for a device

To view or change the resources for a device proceed as follows;

1. In the Add/Remove Hardware Wizard go to the last page and click on the Resources 
button.

The Add New Hardware Wizard properties window is now displayed.
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2. In the Add New Hardware Wizard properties window, select the Resources page and 
click on the Set Configuration Manually button.

The resources page is now updated to show the settings for the current installed SX 
device.
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3. In the Add New Hardware Wizard properties window, select the Resource type you 
require and click on the Change Setting button.

The Edit Memory Range window is now displayed.

4. In the Edit Memory Range window, enter the memory range you want and click on the OK 
button.

If values you have selected are not acceptable to the system, then the Device Manager 
will display a problem icon as shown in the next picture.

5. If the memory settings you have selected are not acceptable to the system, check your 
configuration settings and adjust memory address as required. Otherwise ring Technical 
support.
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Configuring serial ports

To configure SX serial ports under Windows 2000, proceed as follows:

1. In the Windows 2000 desktop, click on the Start button and select 
Settings > Control Panel.

The control panel window is now displayed.

2. In the Control Panel window, click on the System icon.

The System Properties tabbed window is now displayed.

3. In the System Properties window, click on the Hardware tab.

The hardware page is now displayed.

4. In the Hardware page, click on the Device Manager Button.

The Device Manager window is now displayed.
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5. In the Device Manager window, click on the Multiport serial adapters icon to display the 
currently installed devices.

6. In the Device Manager window, double click on the device whose properties you want to 
view or change

The device Properties tabbed window is now displayed.

7. In the device Properties window, click on the Port Settings tab to display the Port 
Settings page.

8. In the Port Settings page, set the Port Number, Baud Rate and other configuration 
parameters you require and then click on the OK button to save changes and close the 
window.

The configuration process is now complete.
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Installing SX under Linux

This section explains how to install the device driver software for the Linux operating system.

• General installation procedure for Linux on page 124

• Installing drivers onto your system on page 125

• Installing utilities on page 127

• Creating devices for the attached ports on page 130

• Loading the driver module into the kernel on page 128

Note

The SX driver for Linux supports up to 4 host cards of either ISA or PCI bus types. 
Under most circumstances the driver will not need to be configured to recognize 
cards of either type.

Once the host card has been installed and the machine has been powered on the 
driver will automatically find any PCI cards installed in the system and register the 
correct interrupt that has been assigned by the BIOS. This is a feature of PCI Plug 
& Play.
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General installation procedure for Linux

The general procedure for installing and configuring host cards, drivers software and 
associated utilities for the Linux operating system is as follows:

1. Install any PCI host cards you require into your system. See Installing a Universal 3.3/
5V PCI host card on page 131.

2. Install the SX Linux drivers onto your system using the procedures described in Installing 
drivers onto your system on page 125.

3. Install the SX Linux utilities onto your system using the procedures described in Installing 
utilities on page 127.

4. Load the driver module into the Kernel and download the firmware onto the host card and 
device concentrators. See Loading the driver module into the kernel on page 128.

5. Create devices for the required ports using the procedures detailed in Creating devices 
for the attached ports on page 130.

6. Install any ISA host cards you require into your system. See Installing an ISA host 
card on page 133.

7. Remove any host cards you want from your system. See Removing host cards on 
page 135.

8. Install the device concentrators or Terminal Adaptors you require for your system. see 
Installing device concentrators on page 136.

9. If required, remove any Device concentrators or Terminal Adaptors you want from your 
system. See Removing Device Concentrators from your system on page 149.

Your system can now use the serial adaptor cards and device concentrators you have 
installed. 
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Installing drivers onto your system

To install the device driver proceed as follows:

1. Make sure you have an up to date Linux kernel source directory installed. This can be 
obtained from ftp://ftp.linux.org or other major Linux web sites, along with instructions 
on how to install and build.

2. Copy the driver patch file onto your system in a temporary directory. For example, /tmp. 

The patch file will be named
sx.patch-<driver vers>-<kernel vers>.gz 
for example:
sx.patch.1.30.2.2.14.gz

3. At the command prompt, uncompress the driver patch file by typing 
gunzip /tmp/sx.patch-1.30-2.2.14.gz and pressing the Enter key.

4. At the command prompt, change directory to the kernel source directory by typing
cd /usr/src/linux and pressing the Enter key.

5. At the command prompt, apply the kernel patch by typing
patch -p1 </tmp/sx.patch-1.30-2.2.14 and pressing the Enter key.

6. If the patch is successful, you will need to enable the driver using the make config or 
make xconfig kernel utility. The SX driver appears in the Character devices section 
and is labelled Specialix SX (and SI) card support. Set this to m for modules.

Note

Before starting to install drivers under Linux, make sure that both a kernel patch file and utilities 
RPM are available. If your Linux Kernel is version 2.2.15 or higher, the Kernel does NOT need 
to be patched.

You can find these on either of the following;

• The CDROM (in the drivers/sx/linux directory)

• Our website http://www.perle.com. 

The latest SX drivers support all host card types i.e. SX and SI/XIO in both ISA and PCI bus 
types.

Note

Driver version 1.30 is required to support the SX PCI host card. The driver is available on 
the CDROM supplied with this product, or from our web site at:
http://www.perle.com 

Note 

You will need to enable Non-standard serial port support in order to select the SX 
Driver.
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7. Now rebuild and install the kernel and modules. See your Linux distribution documentation 
on how to rebuild and install a new kernel and modules. We recommend reading the Kernel-
HOWTO available in /usr/doc/HOWTO.

Note

In order to determine if any ISA cards are present, the driver will search for SX cards at 
6 well known ISA bus addresses (0xC0000, 0xC8000, 0xD0000, 0xD8000, 0xE0000, 
0xE8000). It is recommended that you leave your SX ISA card at the factory default of 
0xD0000, as this is the most common free ISA address slot on the majority of 
machines. If, for some reason your ISA card cannot be left at one of these addresses 
then you will need to modify the sources of the driver and recompile the sx module for 
inclusion into your system. You will need to modify the following line in the /usr/src/
linux/drivers/char/sx.c file:

int sx_probe_addrs[]= {0xc0000,0xc8000, 0xd0000, 0xd8000, 0xe0000, 0xe8000};

Change one of the addresses to the value you have set your ISA card rotary switches 
to e.g. If you have set your rotary switches to F, F (reading from left to right as you look 
at the switches with the ISA bus edge connector closest to you). Then you will need to 
set the address line to:

int sx_probe_addrs[]= {0xff0000};

Once you have made this change you will need to recompile the kernel modules and 
install the new module on your system.

Note: Please consult your Linux distribution documentation on how to rebuild and 
install a new kernel and modules.
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Installing utilities

The driver utilities (sxboot and sxmkdev) are provided in the form of a RedHat Package 
Management file, available on the CDROM or from our web site (http://www.perle.com).

The utilities file is named:
specialix_sxtools-<maj ver>-<min ver>.i386.rpm e.g. specialix_sxtools-4-1.i386.rpm

To install the utilities proceed as follows:

1. Copy the file to a temporary directory and install the utilities using the following command:

rpm -i specialix_sxtools-4-1.i386.rpm

The utilities are now installed in the /usr/bin directory on your machine.
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Loading the driver module into the kernel

In order to make use of the SX devices the driver module must be loaded into the Kernel and 
the firmware must be downloaded onto the host card and device concentrators. This can be 
done manually every time the machine is booted or configured in to the start-up files to 
ensure the driver is always loaded and initialized when the machine completes its boot. See 
the following:

• Loading the driver module manually on page 128

• Loading the driver module automatically on page 129

Loading the driver module manually 

To manually load the module and firmware follow the steps below:

1. Load the SX module into the kernel: modprobe sx

2. Load the SX firmware into the driver: sxboot

sxboot now reports the number of host cards, device concentrators and ports found.

Note

The sxboot application is installed as part of the utilities package. This application must be run 
each time the operating system is initialized, after the driver module has been loaded. It 
contains the download code for the host card and device concentrators and will boot the host 
card and detect the number of ports present on the system.
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Loading the driver module automatically

1. To automatically configure the start up files to load the sx module and firmware copy the 
following script to the file /etc/rc.d/init.d/sx.

2. Create the following symbolic links to the file in the relevant system start-up directories. 
For example, if you machine normally boots into run level 5 you will need to create the 
following symbolic links: ln -s /etc/rc.d/init.d/sx /etc/rc.d/rc5.d/S50sx and 
ln -s /etc/rc.d/init.d/sx /etc/rc.d/rc5.d/K50sx
These links will ensure that the sx start-up script S50sx is run each time the machine is 
booted into run level 5 and that the kill script K50sx is run whenever the machine is 
shutdown.

# sx           This shell script takes care of starting and stopping
#               the SX services.
#
# probe: true

# Source function library.
. /etc/rc.d/init.d/functions

#
# Exit if the sx utilities are not present
#
[ -f /usr/sbin/sxboot ] || exit 0

# See how we were called.
case "$1" in
  start)
        # Start driver and load module.
        action "Starting SX services: " /sbin/modprobe sx
        echo -n "Starting SX Firmware: "
        #
        daemon /usr/sbin/sxboot
        echo
        ;;
  stop)
        # Stop driver and unload module.
        action "Shutting down SX services: " /sbin/modprobe -r sx
        echo
        ;;
  status)
        status sx
        ;;
  restart|reload)
        $0 stop
        $0 start
        ;;
  *)
        echo "Usage: sx {start|stop|restart|reload|status}"
        exit 1
esac

exit 0
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Creating devices for the attached ports

After you have installed the new kernel, modules & hardware, and have rebooted the 
machine. The following procedure can be followed to create devices for the attached ports.

1. Load the SX driver module using the following command:

 modprobe sx.

2. Verify the module has successfully loaded using the lsmod command. The output should 
contain references to the sx module.

3. Ensure all your SX device concentrators are attached. If they are not, then power down 
the system and attach them.

4. Upload the host card firmware to the driver and boot the attached: sxboot

5. Create device nodes for the attached device concentrators: sxmkdev

Your system now has a number of device nodes (/dev/ttyX*) relating to the ports on the 
attached device concentrators.

Note

When you have installed device concentrators or terminal adaptors under Linux, you 
need to do the following after powering up the system;

a. Wait for the machine to boot,

b. Login as root

c. Run sxmkdev -f to create new port devices in the /dev directory.
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Installing a Universal 3.3/5V PCI host card

The latest version of the SX PCI card will fit 3.3V, 5V and universal 3.3/5V PCI card slots in 
your system.

Before commencing installation you can identify card and slot type using the information 
contained in Identifying your SX PCI card and slot type on page 131.You can then install 
your PCI card using the procedures given in Installation procedure on page 132.

Identifying your SX PCI card and slot type

You can identify the PCI card type as shown in the next picture.

The slots on your system will be as shown in the next picture. Note that some systems may 
have a 3.3V only slot as opposed to a 5V and universal 3.3V/5V.

Note

Before installing your SX PCI card note the following;
The latest Universal 3.3V/5V SX PCI card will fit into both 5V and 3.3V PCI slots in your 
system. 
If you are installing an older 5V SX PCI card this will not fit into 3.3V PCI slots in your system. 

SX 5v PCI card SX 3.3v/5v universal PCI card

The new universal 
3.3V/5V PCI car has 
two notches on the 
card edge connector 
where as the 5V PCI 
card has only one.

Rear of System

5V PCI slot 

3.3V PCI slot

Universal 3.3V/5V PCI 
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Installation procedure

To install a PCI host card proceed as follows;

1. Turn off the power to your system and disconnect the mains supply.

2. Remove the system cover to expose the inside of the connector panel for host cards.

3. Insert the PCI card you want to install into a vacant host card slot and secure in place as 
shown in the next picture.

4. Repeat step 3. until you have installed all the PCI cards you want. Now replace and 
secure the system cover. 

Installation of PCI host cards is now complete. For further details about installing host cards 
including other types, see Before you start on page 26.

Warning

Dangerous voltages exist inside computer systems. Before 
installing host cards in your system, turn off the power supply 
and disconnect the mains lead.

Note 

If you are installing an older 5V version of the SX PCI card this will only fit into 5V PCI 
slots on your system. 5V SX PCI cards will not fit into the later 3.3V PCI slots.

Caution

Full anti-static precautions should be taken when handling host 
cards.
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Installing an ISA host card

Setting the 
address on an ISA 
host card

Before you install an ISA card in your system you need to physically set the address for the 
card using the two rotary switches SW1 and SW2 and jumper J2 provided on the host card 
(shown in the next picture).

To set the address for an ISA host card proceed as follows;

1. Choose an address you want to use for the host card in hexidecimal. On the host card set 
the two rotary switches SW1 and SW2 and jumper J2 to the first three digits of the 
address you want as shown by the next example.

Caution

Full anti-static precautions should be taken when handling host cards.

Host card Address Set SW1 to.. Set SW2 to.. set J2 to...

C0000 0 C No jumper

C8000 0 C Jumper fitted

D0000
(Default setting)

0 D No jumper

D8000 0 D Jumper fitted

E0000 0 E No jumper

E8000 0 E Jumper fitted

Sets first digit of address in hexidecimal

Sets second digit of address in hexidecimal

Sets third digit of address in hexidecimal.
Jumper fitted=8, No jumper fitted=0
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Mechanical 
installation

You can now install the ISA host card in your system.To do this proceed as follows;

2. Turn off the power to your system and disconnect the mains supply.

3. Remove the system cover to expose the inside of the connector panel for host cards.

4. Insert the ISA card you want to install into a vacant host card slot and secure in place as 
shown in the next picture.

5. Repeat step 3. until you have installed all the ISA cards you want.

6. Replace and secure the system cover.

7. Plug in the mains lead and turn on the power.

Installation of ISA host cards is now complete. For further details about installing host cards 
including other types, see Before you start on page 26.

Note

The exact location of host card slots varies for different systems, for exact mechanical 
details of your system, refer to your system documentation.

Warning

Dangerous voltages exist inside computer systems. Before 
installing host cards in your system, turn off the power supply 
and disconnect the mains lead.

Caution

Full anti-static precautions should be taken when handling host 
cards.
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Removing host cards

To remove a host card from your system proceed as follows;

1. Turn off the power to your system and disconnect the mains supply.

2. Remove the system cover to expose the inside of the connector panel for host cards.

3. Remove all cables plugged into the host card.

4. Undo the securing screw for the host card you want to remove then lift the card out of its 
slot as shown in the next picture (ISA card shown).

5. Repeat step 4. until you have removed all the host cards you want.

6. Replace and secure the system cover.

7. Plug in the mains lead and turn on the power.

Removal of host cards is now complete. For further details about installation of host cards 
including other types, see Before you start on page 26.

Note

The exact location of host card slots varies for different systems, for exact mechanical 
details of your system, refer to your system documentation.

Warning

Dangerous voltages exist inside computer systems. Before 
removing host cards from your system, turn off the power supply 
and disconnect the mains lead.

Caution

Full anti-static precautions should be taken when handling host 
cards.
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Installing device concentrators

Device Concentrators (SXDCs), Terminal Adaptors (TAs) and Multiple Terminal Adaptors 
(MTAs) are basically serial connection blocks which provide a number of ports depending on 
type. This section describes the mechanical installation of SX Device concentrators 
(SXDCs), terminal adaptors (TAs) and Multiple Terminal Adaptors (MTAs) and includes The 
following;

• Installing SX Device Concentrators (SXDCs) on page 137

• Installing Modular Terminal Adaptors (MTAs) on page 142

• Installing Terminal Adaptors (TAs) on page 146.
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Installing SX Device Concentrators (SXDCs)

Before installing your SXDCs, please read Before you start on page 26.

Installation procedure

To install SX device concentrators (SXDCs) on your system proceed as follows;

1. Turn the power off to your computer system and disconnect the supply.

2. If you want to use more than SXDC, add extra units to the first one using the procedures 
described in Joining SXDCs together on page 138.

3. If required mount the SXDC(s) using the procedures given in Mounting SXDCs on 
page 141.

4. Connect each host card to the first of the SXDCs you want to use using the 1.5 metre bus 
extension cable supplied with the host card.

5. Attach the peripherals you want to the device concentrators using suitable cables.

6. Power up your computer system.

Installation of SXDCs is now complete.

Warning

Before installing Device concentrators on your system, turn off 
the power supply to your system and disconnect the mains lead.

Note

When connecting SX host cards to Device concentrators or terminal adaptors you 
should only use the 1.5 metre bus extension cable supplied with your SX host 
card. Using any other cable will invalidate your EMC and noise warranty.

SXDC shown
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Joining SXDCs together

To join SXDCs together proceed as follows;

1. Remove the end covers on the Device concentrator as shown in the next picture. 

2. Remove the SXDC links (shaped like an H) from each end of the SXDC as shown in the 
next picture.

Note

Do NOT join together different device concentrator types. You can only 
connect device concentrators as follows;

SXDC8s to SXDC8s

MTAs to MTAs, and 

TA4s/TA8s to TA4s/TA8s

No other combinations are permitted.

Warning

Do NOT connect and disconnect device concentrators while your machine is 
powered on. To do so will damage electronic circuitry and be a safety 
hazard.
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3. Push the first SXDC8 into the second SXDC8 via their bus connectors as shown in the 
next picture (retain the links as you will need these at a later stage).

4. Insert one SXDC link at each end of the joined pair of SXDCs into the H shaped apertures 
provided as shown in the next picture.

5. Replace the covers at either end of the SXDCs as shown in the next picture.
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Joining is now complete.
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Mounting SXDCs

The procedure for mounting SXDCs units is as follows;

1. On the unit gently prize off the caps at either end of the unit to reveal the wall mounting 
holes as shown in the next picture.

2. Screw the unit to the wall through the holes provided using appropriate screws or 
fasteners for your installation.

3. Replace the caps at the ends of the unit.

Wall mounting of the unit is now complete. 

Warning

Before you wall mount the unit, turn off and disconnect the power 
supply.

Note

The removable caps are located on the bottom of MTA units and on 
the top of SXDC units.
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Installing Modular Terminal Adaptors (MTAs)

Before installing your Modular Terminal Adaptors (MTAs), please read Before you start on 
page 26.

Installation procedure

To install SX Modular Terminal Adaptors (MTAs) on your system proceed as follows;

1. Turn the power off to your computer system and disconnect the supply.

2. If you want to use more than MTA, add extra units to the first one using the procedures 
described in Joining MTAs together on page 143.

3. If required mount the MTA(s) using the procedures given in Mounting MTAs on 
page 145.

4. Connect each host card to the first of the MTAs you want to use using the 1.5 metre bus 
extension cable supplied with the host card.

5. Attach the peripherals you want to the MTA(s) using suitable cables and power up your 
computer system.

Installation of MTAs is now complete.

Warning

Before installing MTAs on your system, turn off the power supply 
to your system and disconnect the mains lead.

Note

When connecting SX host cards to Device concentrators or terminal adaptors you 
should only use the 1.5 metre bus extension cable supplied with your SX host 
card. Using any other cable will invalidate your EMC and noise warranty.

SXDC shown
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Joining MTAs together

To join MTAs together proceed as follows;

1. Remove the brackets on the underside of each MTA as shown in the next picture (hint, 
unclip brackets by lifting vertically). 

2. Push the first MTA into the second MTA via their bus connectors, then join the two MTAs 
with a single bracket at each end as shown in the next picture.

Note

Do NOT join together different device concentrator types. You can only 
connect device concentrators as follows;

SXDC8s to SXDC8s

MTAs to MTAs, and 

TA4s/TA8s to TA4s/TA8s

No other combinations are permitted.

Warning

Do NOT connect and disconnect device concentrators while your machine is 
powered on. To do so will damage electronic circuitry and be a safety 
hazard.
SX User Guide 
Installing device concentrators

Page 143

Chapter 2 Installing hardware and software



SX User Guide 
Installing device concentrators

Page 144

Chapter 2 Installing hardware and software



Mounting MTAs

The procedure for mounting SX units is as follows;

1. On the unit gently prize off the caps at either end of the unit to reveal the wall mounting 
holes as shown in the next picture.

2. Screw the unit to the wall through the holes provided using appropriate screws or 
fasteners for your installation.

3. Replace the caps at the ends of the unit.

Wall mounting of the unit is now complete. 

Warning

Before you wall mount the RTA, turn off and disconnect the 
power supply to the unit.

Note

The removable caps are located on the bottom of MTA units and on 
the top of SXDC8 units.
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Installing Terminal Adaptors (TAs)

Before installing your Terminal Adaptors (TAs), please read Before you start on page 26.

Installation procedure

To install SX Terminal Adaptors (TAs) on your system proceed as follows;

1. Turn the power off to your computer system and disconnect the supply.

2. If you want to use more than TA, add extra units to the first one using the procedures 
described in Joining TAs together on page 147.

3. If required mount the TA(s) using the procedures given in Mounting TAs on page 148.

4. Connect each host card to the first of the TAs you want to use using the 1.5 metre bus 
extension cable supplied with the host card.

5. Attach the peripherals you want to the TAs using suitable cables.

6. Power up your computer system.

Installation of TAs is now complete.

Warning

Before installing Device concentrators on your system, turn off 
the power supply to your system and disconnect the mains lead.

Note

When connecting SX host cards to Device concentrators or terminal adaptors you 
should only use the 1.5 metre bus extension cable supplied with your SX host 
card. Using any other cable will invalidate your EMC and noise warranty.

SXDC shown
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Joining TAs together

The procedure for joining TAs is as follows;

1. Push the first TA into the second TA via their bus connectors as shown in the next picture.

2. Now join the two TAs with a single bracket at each end then secure each bracket in place 
with the screws provided.

Note

Whether you are joining the same type of device concentrator (for example, TA4s 
to TA4s) or mixing TA4s and TA8s the procedure for joining them is the same:
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Mounting TAs

Note 

The TA4 or the TA8 units are designed for desktop placement 
only, they are not suitable for wall mounting.
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Removing Device Concentrators from your system

To remove SX device concentrators (including SXDCs, MTAs and TAs) from your system 
proceed as follows;

1. Turn the power off to your computer system and disconnect the supply.

2. If required, disconnect the bus extension cable from the device concentrators.

3. If you need to separate multiple device concentrators remove any joining brackets or links 
prior to separating the units.

4. Separate the device concentrators units as required to remove the unit you want.

You can now re-assemble your system in the revised configuration you require. See 
Installing device concentrators on page 136 for further details.

Warning

Before removing device concentrators from your system, turn off 
the power supply to your system and disconnect the mains lead.
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SX
User Guide

Chapter 3  Cabling information

You need to read 
this chapter if you 
want to...

You need to read this chapter if you want cabling information for the Perle SX serial 
connectivity system hardware.

This chapter provides cabling and connector pinout information for the Perle SX system. 
Included are details of about which cables to use, their pinouts and details of standard cables 
for use with SX products available from Perle. 

This chapter includes the following sections;

• Connecting SX host cards to Device Concentrators on page 152

• Device Concentrator top connector pinouts on page 153

• Connecting combinations of Device Concentrator types on page 163

• Connecting Device Concentrators to terminals on page 165

• Cable connector pinouts on page 171

• Loopback connector pinouts on page 178.
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Connecting SX host cards to Device Concentrators

You connect each host card to the first of the Device Concentrator you want to use using the 
1.5 metre bus extension cable supplied with the host card.

For details of installing host cards and device concentrators, see  Installing a Universal 3.3/
5V PCI host card and  Installing an ISA host card in Chapter 2 Installing hardware and 
software.

Note

When connecting SX host cards to Device concentrators or terminal adaptors you 
should only use the 1.5 metre bus extension cable supplied with your SX host 
card. Using any other cable will invalidate your EMC and noise warranty.

SXDC shown
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Device Concentrator top connector pinouts 

To view the connector pinout for the various types of SX device concentrators see the 
following;

• SXDC top connector guide; on page 154

• MTA top connector guide on page 154

• TA top connector guide on page 154.
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SXDC top connector guide;

MTA top connector guide

TA top connector guide

SXDC type To find details...

SXDC8/RJX See RJ45 female SXDC connector pinout on page 155

SXDC8/DX See DB25 female SXDC connector pinout on page 157

SXDC8/MX See DB25 male SXDC connector pinout on page 160

SXDC8/PX See SXDC8/PX DB25 parallel female connector pinout on page 162

MTA type To find details...

MTA8/RJX See RJ45 female MTA connector pinout on page 156

MTA8/D See DB25 female MTA connector pinout on page 158

MTA8/M See DB25 male MTA connector pinout on page 161

MTA8/PX See SXDC8/PX DB25 parallel female connector pinout on page 162

TA type To find details...

TA4 See DB25 female TA connector pinout on page 159

TA8 See DB25 female TA connector pinout on page 159
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RJ45 female SXDC connector pinout

Pin Signal Direction Description

1 DCD In Data Carrier Detect

2 DTR Out Data Terminal Ready

3 DSR In Data Set Ready

4 S/GND Signal ground

5 TXD Out Transmit Data

6 RXD In Receive Data

7 RTS Out Request To Send

8 CTS In Clear To Send 

Shield

Pin 1 (looking into connector)
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RJ45 female MTA connector pinout

Pin Signal Direction Description

1 DCD In Data Carrier Detect

2 DTR Out Data Terminal Ready

3 DSR In Data Set Ready

4 S/GND Signal ground

5 TXD Out Transmit Data

6 RXD In Receive Data

7 RTS Out Request To Send

8 CTS In Clear To Send 

Shield

Pin 1 (looking into connector)
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DB25 female SXDC connector pinout

Pin Signal Direction Description

1 Chassis Chassis ground

2 RXD In Transmit Data

3 TXD Out Receive Data

4 RTS In Request To Send

5 CTS Out Clear To Send

6 DSR Out Data Set Ready

7 GND Ground

8 DCD In Data Carrier Detect

20 DTR In Data Terminal Ready

22 RI In Ring Indicator

Pin 1 (looking into connector)
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DB25 female MTA connector pinout

Pin Signal Direction Description

1 Chassis Chassis ground

2 RXD In Transmit Data

3 TXD Out Receive Data

4 RTS In Request To Send

5 CTS Out Clear To Send

6 DSR Out Data Set Ready

7 GND Ground

8 DCD In Data Carrier Detect

20 DTR In Data Terminal Ready

22 RI In Ring Indicator

Pin 1 (looking into connector)
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DB25 female TA connector pinout

Pin Signal Direction Description

1 Chassis Chassis ground

2 RXD In Transmit Data

3 TXD Out Receive Data

4 RTS In Request To Send

5 CTS Out Clear To Send

6 DSR Out Data Set Ready

7 GND Ground

8 DCD In Data Carrier Detect

20 DTR In Data Terminal Ready

22 RI In Ring Indicator

Pin 1 (looking into connector)
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DB25 male SXDC connector pinout

Pin Signal Direction Description

2 TXD Out Transmit Data

3 RXD In Receive Data

4 RTS Out Request To Send

5 CTS In Clear To Send

6 DSR In Data Set Ready

7 GND Ground

8 DCD In Data Carrier Detect

20 DTR Out Data Terminal Ready

22 RI In Ring Indicator

Pin 1 (looking into connector)
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DB25 male MTA connector pinout

Pin Signal Direction Description

2 TXD Out Transmit Data

3 RXD In Receive Data

4 RTS Out Request To Send

5 CTS In Clear To Send

6 DSR In Data Set Ready

7 GND Ground

8 DCD In Data Carrier Detect

20 DTR Out Data Terminal Ready

22 RI In Ring Indicator

Pin 1 (looking into connector)
SX User Guide 
Device Concentrator top connector pinouts

Page 161

Chapter 3 Cabling information



SXDC8/PX DB25 parallel female connector pinout

Pin Signal Direction Description

1 STROBEN* Output PSTROBE

2 D0 Output DATA 1

3 D1 Output DATA 2

4 D2 Output DATA 3

5 D3 Output DATA 4

6 D4 Output DATA 5

7 D5 Output DATA 6

8 D6 Output DATA 7

9 D7 Output DATA 8

10 PACKN* Input ACK

11 PBUSY Input BUSY

12 PPE Input PE

13 PSLCT Input SLCT

14 AUTOFDXT* Output AUTOFEED

15 PERRORN* Input FAULT

16 PINITN* Output INPUT PRIME

17 PSLINN* Output SLCT IN

18 GND — GROUND

19 GND — GROUND

20 GND — GROUND

21 GND — GROUND

22 GND — GROUND

23 GND — GROUND

24 GND — GROUND

25 GND — GROUND

Pin 1 (looking into connector)
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Connecting combinations of Device Concentrator types

This section explains about mixing different types of device concentrator (TA, MTA and 
SXDC8) on a connection to a single host card and includes the following:

• Connecting a single host card to device concentrators on page 169

• Connecting multiple host cards to device concentrators on page 170

Connecting a single host card to device concentrators

Note

You cannot connect multiple device concentrator types to single SX 
host card. For example SXDCs and MTAs.

To connect multiple device concentrator types to a single machine for 
example, use multiple host cards, one for each device concentrator 
type.

Device 
concentrator 
type

Maximum number of ports 
per host card Device concentrators required

TA8 and TA4 32 Any mixture of TA8s and TA4s 
giving 32 ports.

TA8 32 4 TA8s.

TA4 16 4 TA4s.

MTA 128 4 MTAs.

SXDC* 128 SXDC8s.
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Connecting multiple host cards to device concentrators

Note

When using multiple host cards, fir example in the same machine, use one host card for each 
device concentrator type.

You cannot connect multiple device concentrator types to s single SX host card. For example 
SXDCs and MTAs.
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Connecting Device Concentrators to terminals

To connect your Device Concentrator to a terminal you use the cable types detailed in the 
next table

Device Concentrator type
Cable description 
(Device Concentrator to Terminal) 

To find 
details...

SXDC8/RJX RJ45 male to DB25 male DTE. See page 
171.

SXDC8/DX DB25 male to DB25 male DTE See page 
172.

SXDC8/MX DB25 female to DB25 male DTE See page 
173.

SXDC8/PX port1 DB25 parallel male to centronics parallel See page 
177

SXDC8/PX ports 2,3 and 4 DB25 male to DB25 male DTE See page 
172

SXDC8/PX ports 5, 6,7 and 8 DB25 male to DB25 male DTE See page 
172

SXDC8/422 DB25 male to DB25 male DTE See page 
173.

MTA/RJX RJ45 male to DB25 male DTE. See page 
171.

MTA/DX DB25 male to DB25 male DTE See page 
172.

MTA/MX DB25 female to DB25 male DTE See page 
173.

MTA/PX port1 DB25 parallel male to centronics parallel See page 
177

MTA/PX ports 2,3 and 4 DB25 male to DB25 male DTE See page 
172

MTA/PX ports 5, 6,7 and 8 DB25 male to DB25 male DTE See page 
172

MTA/422 DB25 male to DB25 male DTE See page 
173.

TA4 DB25 male to DB25 male DTE See page 
171

TA8 DB25 male to DB25 male DTE See page 
171
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Connecting Device Concentrators to modems

To connect your Device Concentrator to a modem you use the cable types detailed in the 
next table;

Device Concentrator type
Cable description
(RTA to Terminal) To find details ...

SXDC8/RJX RJ45 male to DB25 male DCE See page 174.

SXDC8/DX DB25 male to DB25 male DCE See page 175.

SXDC8/MX DB25 female to DB25 male DCE See page 176.

SXDC8/P port1 DB25 parallel male to centronics parallel See page 177.

SXDC8/P ports 2,3 and 4 DB25 male to DB25 male DTE See page 172.

SXDC8/P ports 5, 6,7 and 8 DB25 male to DB25 male DTE See page 172.

SXDC8/422 DB25 male to DB25 male DCE See page 175.

MTA/RJX RJ45 male to DB25 male DCE See page 174.

MTA/DX DB25 male to DB25 male DCE See page 175.

MTA/MX DB25 female to DB25 male DCE See page 176.

MTA/P port1 DB25 parallel male to centronics parallel See page 177.

MTA/P ports 2,3 and 4 DB25 male to DB25 male DTE See page 172.

MTA/P ports 5, 6,7 and 8 DB25 male to DB25 male DTE See page 172.

MTA/422 DB25 male to DB25 male DCE See page 175.

TA4 DB25 male to DB25 male DCE See page 175.

TA8 DB25 male to DB25 male DCE See page 175.
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Connecting Device Concentrators to parallel printers

To connect your Device Concentrator to a parallel printer you use the cable types detailed in 
the next table;

RTA type
Cable description 
(RTA to Terminal) 

To find 
details...

SXDC8/PX DB25 Parallel male to centronics parallel connector See page 
177.

MTA/PX DB25 Parallel male to centronics parallel connector See page 
177.
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Connecting Device Concentrators to serial printers

To connect your RTA to a serial printer you use the cable types detailed in the next table

RTA type
Cable description
(RTA to Terminal) To find details...

SXDC8/RJX RJ45 male to DB25 male DTE See page 171.

SXDC8/DX DB25 male to DB25 male DTE See page 172.

SXDC8/MX DB25 female to DB25 male DTE See page 173.

SXDC8/P port1 DB25 parallel male to centronics 
parallel 

See page 177

SXDC8/P ports 2,3 and 4 DB25 male to DB25 male DTE See page 172

SXDC8/P ports 5, 6,7 and 8 DB25 male to DB25 male DTE See page 172

SXDC8/422 DB25 male to DB25 male DTE See page 172.

MTA/RJX RJ45 male to DB25 male DTE See page 171.

MTA/DX DB25 male to DB25 male DTE See page 172.

MTA/MX DB25 female to DB25 male DTE See page 173.

MTA/P port1 DB25 parallel male to centronics 
parallel 

See page 177

MTA/P ports 2,3 and 4 DB25 male to DB25 male DTE See page 172

MTA/P ports 5, 6,7 and 8 DB25 male to DB25 male DTE See page 172

MTA/422 DB25 male to DB25 male DTE See page 172.

TA4 DB25 male to DB25 male DTE See page 172.

TA8 DB25 male to DB25 male DTE See page 172.
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Connecting Device concentrators to host cards

This section explains about mixing different types of device concentrator (TA, MTA and 
SXDC8) on a connection to a single host card and includes the following:

• Connecting a single host card to device concentrators on page 169

• Connecting multiple host cards to device concentrators on page 170

Connecting a single host card to device concentrators

Note

You cannot connect multiple device concentrator types to a single SX 
host card. For example SXDCs and MTAs.

To connect multiple device concentrator types to a single machine for 
example, use multiple host cards, one for each device concentrator 
type.

Device 
concentrator 
type

Maximum number of ports 
per host card Device concentrators required

TA8 and TA4 32 Any mixture of TA8s and TA4s 
giving 32 ports.

TA8 32 4 TA8s.

TA4 16 4 TA4s.

MTA 128 4 MTAs.

SXDC* 128 SXDC8s.
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Connecting multiple host cards to device concentrators

Note

When using multiple host cards, for example in the same machine, use one host 
cards for each device concentrator type.

You cannot connect multiple device concentrator types to a single SX host card. For 
example SXDCs and MTAs.
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Cable connector pinouts

RJ45 male to DB25 male DTE for connection to DCE devices

Typical uses This type of cable is used to connect to DCE devices such as Modems.

Cable diagram

Connector pinout table

Pin 1
(looking into 
connector)Pin 1

(looking into 
connector)

RJ45 DB25

Pin Signal Direction Description Pin Signal Description

1 DCD In Data Carrier Detect 8 DCD Data Carrier Detect

2 DTR Out Data Terminal Ready 20 DTR Data Terminal Ready

3 DSR In Data Set Ready 6 DSR Data Set Ready

4 S/GND Signal ground 7 S/GND Signal ground

5 TXD Out Transmit Data 2 TXD Transmit Data

6 RXD In Receive Data 3 RXD Receive Data

7 RTS Out Request To Send 4 RTS Request To Send

8 CTS In Clear To Send 5 CTS Clear To Send

Shield Chassis ground
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DB25 male to DB25 male DTE for connection to DCE devices

Typical uses This type of cable is used to connect to DCE devices such as Modems.

Cable diagram

Connector pinout table

Pin 1
(looking into 
connector)

Pin 1
(looking into 
connector)

DB25 DB25

Pin Signal Direction Description Pin Signal Description

1 Chassis Chassis ground 1 Chassis Chassis ground

2 TXD In Transmit Data 3 RXD Receive Data

3 RXD Out Receive Data 2 TXD Transmit Data

4 RTS In Request To Send 5 CTS Clear To Send

5 CTS Out Clear To Send 4 RTS Request To Send

6 DSR Out Data Set Ready 20 DTR Data Terminal Ready

7 GND Ground 7 GND Ground

8 DCD In Data Carrier Detect 8 DCD Data Carrier Detect

20 DTR In Data Terminal Ready 6 DSR Data Set Ready
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DB25 female to DB25 male DTE for connection to DCE devices

Cable diagram

Connector pinout table

Pin 1
(looking into 
connector)

Pin 1
(looking into 
connector)

DB25 DB25

Pin Signal Direction Description Pin Signal Description

2 TXD Out Transmit Data 2 TXD Transmit Data

3 RXD In Receive Data 3 RXD Receive Data

4 RTS Out Ready to send 4 RTS Ready to send

5 CTS In Clear to send 5 CTS Clear to send

6 DSR In Data Set Ready 6 DSR Data Set Ready

7 GND Ground 7 GND Ground

8 DCD In Data Carrier Detect 8 DCD Data Carrier Detect

20 DTR Out Data Terminal Ready 20 DTR Data Terminal Ready
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RJ45 male to DB25 female DCE for connection to DTE devices

Typical uses This type of cable is used to connect to DTE devices such as Terminals, PCs or printers.

Cable diagram

Connector pinout table

Pin 1
(looking into 
connector)

Pin 1
(looking into 
connector)

RJ45 DB25 pin

Pin Signal Direction Description Pin Signal Description

1 DCD In Data Carrier Detect 8 DCD Data Carrier Detect

2 DTR Out Data Terminal Ready 6 DSR Data Set Ready

3 DSR In Data Set Ready 20 DTR Data Terminal Ready

4 S/GND Signal ground 7 S/GND Signal ground

5 TXD Out Transmit Data 3 RXD Receive Data

6 RXD In Receive Data 2 TXD Transmit Data

7 RTS Out Request To Send 5 CTS Clear To Send

8 CTS In Clear To Send 4 RTS Request To Send

Shield Chassis ground
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DB25 male to DB25 female DCE for connection to DTE devices

Typical uses This type of cable is used to connect to DTE devices such as Terminals, PCs or printers.

Cable diagram

Connector pinout table

Pin 1
(looking into 
connector)

Pin 1
(looking into 
connector)

DB25 DB25

Pin Signal Direction Description Pin Signal Description

2 TXD In Transmit Data 2 TXD Transmit Data

3 RXD Out Receive Data 3 RXD Receive Data

4 RTS In Request To Send 4 RTS Request To Send

5 CTS Out Clear To Send 5 CTS Clear To Send

6 DSR Out Data Set Ready 6 DSR Data Set Ready

7 GND Ground 7 GND Ground

8 DCD In Data Carrier Detect 8 DCD Data Carrier Detect

20 DTR In Data Terminal Ready 20 DTR Data Terminal Ready
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DB25 female to DB25 female DCE for connection to DTE devices

Typical uses This type of cable is used to connect to DTE devices such as Terminals, PCs or printers.

Cable diagram

Connector pinout table

Pin 1
(looking into 
connector)

Pin 1
(looking into 
connector)

DB25 DB25

Pin Signal Direction Description Pin Signal Description

2 TXD Out Receive Data 3 RXD Transmit Data

3 RXD In Transmit Data 2 TXD Receive Data

4 RTS Out Request To Send 5 CTS Clear To Send

5 CTS In Clear To Send 4 RTS Request To Send

6 DSR In Data Set Ready 20 DTR Data Terminal Ready

7 GND Ground 7 GND Ground

8 DCD In Data Carrier Detect 8 DCD Data Carrier Detect

20 DTR Out Data Terminal Ready 6 DSR Data Set Ready
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DB25 parallel male to Centronics parallel

Note

The following pinout is included for information only and shows the DB25 pinout only. If you 
require this type of cable, we recommend obtaining a suitable standard PC parallel printer cable 
rather than making one.

* Denotes active low.

Pin Signal Direction Description

1 STROBEN* Output PSTROBE

2 D0 Output DATA 1

3 D1 Output DATA 2

4 D2 Output DATA 3

5 D3 Output DATA 4

6 D4 Output DATA 5

7 D5 Output DATA 6

8 D6 Output DATA 7

9 D7 Output DATA 8

10 PACKN* Input ACK

11 PBUSY Input BUSY

12 PPE Input PE

13 PSLCT Input SLCT

14 AUTOFDXT* Output AUTOFEED

15 PERRORN* Input FAULT

16 PINITN* Output INPUT PRIME

17 PSLINN* Output SLCT IN

18 GND — GROUND

19 GND — GROUND

20 GND — GROUND

21 GND — GROUND

22 GND — GROUND

23 GND — GROUND

24 GND — GROUND

25 GND — GROUND
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Loopback connector pinouts

The type of loopback connector you require depends upon the connector type fitted to your 
device concentrator (described in Device Concentrator top connector pinouts on 
page 153) See one of the following sections for pinouts;

• Loopback pinouts for RJ45 female connectors on page 179

• Loopback pinouts for DB25 female connectors on page 180

• Loopback pinouts for DB25 male connectors on page 181.

For details of loopback and other tests see Appendix D Troubleshooting.
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Loopback pinouts for RJ45 female connectors

To test this type of port, your loopback connector needs to join together the connector pins 
shown in the next picture.

For details of RJ45 female connector pinouts see page 155.
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5
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7

8

DCD

DTR

DSR

TXD

RXD
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SX User Guide 
Loopback connector pinouts

Page 179

Chapter 3 Cabling information



Loopback pinouts for DB25 female connectors

To test this type of port, your loopback connector needs to join together the connector pins 
shown in the next picture.

For details of DB25 female connector pinouts see page 157.
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Loopback pinouts for DB25 male connectors

To test this type of port, your loopback connector needs to join together the connector pins 
shown in the next picture.

For details of DB25 male connector pinouts see page 160.
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Chapter 4  Quick reference

You need to read 
this chapter if you 
want to...

You need to read this chapter if you want information in quick reference form about the 
utilities provided with the SX Serial adaptor cards.

This chapter provides a quick reference guide to the software utilities provided with the SX 
Serial adaptor cards. The utilities are grouped under operating system and include main 
windows and menus. In addition, cross references are provided for further information about 
each area.

This chapter includes the following sections;

• Solaris utilities on page 183

• SCO OpenServer 5 utilities on page 184

• SCO UnixWare utilities on page 189
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Solaris utilities

sxisacfg utility

The sxisacfg utility allows you to define addresses and IRQ levels for SX ISA host cards you 
add to the system. If are unable to find a free interrupt level for the card you are installing, 
sxisacfg also allows you to toggle the driver into polled mode (this is a global property that 
applies to all cards).

The command syntax for this utility is as follows;

sxisacfg [-n<name>] [-m<addr>] [-i<irq>] [-p] [-a<ioaddr>] [-d<name>]

Where:

Some typical example commands are shown below;

For information on using the rioisacfg utility to assign host card addresses and IRQ levels, 
see Assigning ISA host card addresses and IRQ levels on page 31 in Chapter 2 
Installing hardware and software.

Command Description

-n<name> Specifies the host card name.

-m<addr> Specifies host card memory address.

-i<irq> Specifies host card interrupt level.

-p Toggles the state of polling (default state 
is interrupt mode).

-a<ioaddr> Specifies the host card i/o address.

-d<name> Deletes the named host card entry.

-l Lists the current configuration including 
the ISA cards installed and the Polling 
mode selected.

Example command Description

/etc/sxisacfg -n ISA1 -m 0xD0000 -i 9 Set host card 
parameters. 

sxisacfg -p Sets polling.

sxisacfg -d ISA1 Deletes an ISA card.
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SCO OpenServer 5 utilities

A number of utilities are provided for use with the SCO OpenServer 5 operating system. See 

the following sections for information about main windows and menus;

• Host Card Configuration utility on page 184

• Serial Port Enable utility on page 186

Host Card Configuration utility

The main window for the Host Card Configuration tool is shown in the next picture. See 
Menu map on page 185 for details of menus.

For menu, 
see page 185
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Menu map The Host Card Configuration tool menu is as follows;

Menu option Description

Card > Quit Quit the Host Card Configuration tool 
without saving.

See page 47.

Add Add a new host card address.

See page 47.

Remove Remove a host card address.

See page 47.

Edit Edit an existing host card address.

See page 47.

Save and exit Exit the Host Card Configuration tool and 
save any changes.

See page 47.
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Serial Port Enable utility

The main window for the Serial Port Enable tool is shown in the next picture. See Menu 
map on page 187 for details of menus.

Menus. See page 185

Select a getty 
definition 
here. 
page 57.

Select a 
terminal type 
here.
See page 57.

Select one or 
more ports 
from this list.
See page 57 .

Enables or 
disables flow 
control.
See page 58.

Enables or disables login.
See page 58.
SX User Guide 
SCO OpenServer 5 utilities

Page 186

Chapter 4 Quick reference



Menu map The Serial Port Enable utility menu is as follows;

Menu option Description

Show > Modems Displays all ports configured as modems.

See page 58.

Direct Shows all ports configured to directly connect 
to a terminal with no modem in between.

See page 58.

Unconfigured Displays all unconfigured ports.

See page 58.

All Displays all ports.

See page 58.

Exit Exits the Serial Port Enable utility and saves 
any changes.

See page 59.

Locks > Lock Locks Serial Port Enable settings preventing 
other users from changing them.

See page 59.

Unlock Unlocks Serial Port Enable settings allowing 
other users to change them.

See page 59.

Change > VT Type Changes the VT type used by the currently 
selected port to that currently highlighted in the 
VT Type field.

See page 57.

ixon/ixany Changes the ixon/ixany setting for the currently 
selected port to that currently set in either the 
ixon/ixany toggle button.

See page 58.
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Stats > Enable Enables recording of port statistics for the 
currently selected port.

See page 55.

Disable Disables recording of port statistics for the 
currently selected ports.

See page 55.

Clear Clears the recorded port statistics for the 
currently selected ports.

See page 55.

Show Displays shows the port statistics recorded for 
the currently selected port in a separate Port 
Statistics window.

See page 55.

Diags > Test Runs the Ports Diagnostics Utility on the 
currently selected port.

See page 215.

Pins Displays the pin status for the currently 
selected port in a separate Pin Status 
window.

See page 215.

Settings Displays the port settings for the currently 
selected port in a separate Port Settings 
window.

See page 215.

Menu option Description
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SCO UnixWare utilities

Device configuration utility

The main window for the Device Configuration Utility is shown in the next picture.

Menu map The menu is as follows;

Menu option Description

Hardware Device Configuration > Displays the Hardware Device Configuration 
window which allows you to set host card 
addresses and IRQ levels.

See page 85.

Software Device Drivers > Displays the Software Driver Device selections 
window which allows you to select a software 
device driver type to display.

See page 85.

Apply Changes & Exit DCU > Apply configuration changes and exit the 
Hardware Device Configuration Utility.

See page 85.

Exit DCU and Cancel Changes > Exit the Hardware Device Configuration Utility 
and cancel any changes.

See page 85.
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Serial Manager

Main window The main window for the Serial Manager is shown in the next picture.You can display this 
window in one of two views, Board view and Ports view. See page 191 for menu maps.

Boards view
Displays the host cards present on 
the system. To obtain this view, click 
on the View >  Boards menu 
option.

Ports view
Displays the serial ports present on 
the system. To obtain this view, click 
on the View >  Ports menu option.
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Menu map The Serial Manager menu is as follows;

Menu option Description

Host > Open Host Selects a host machine.

See your SCO UnixWare documentation for 
further details.

Exit Exit Serial Manager.

Port > Modify Modifies serial port settings.

See page 95.

View > Ports Show serial ports available for the currently 
selected host card.

See page 95.

Boards Show host cards present on the system.

See page 95.
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Appendix A Serial port device names 

You need to read 
this appendix if you 
want to...

You need to read this appendix if you want information about device names for the Perle SX 
serial adaptor cards.

This appendix provides information about the device nodes associated with each serial port 
for the Perle SX serial adaptor cards. Included are naming conventions, functions, file 
locations and some additional information about the Data terminal ready and Ready to send 
signals.

This chapter includes the following sections;

• Under Solaris on page 193

• Under SCO OpenServer on page 194

• Under SCO UnixWare on page 195

• Under Windows NT on page 196

• Under Windows 2000/XP/Server 2003/Vista/Server 2008 on page 196

• Under Linux on page 196.
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Under Solaris

Device node details

Each serial port has three device nodes associated with it. Each node takes the form of a file 
which you can access from operating system utilities and user applications. Details of these 
nodes are shown in the next table.

Device name Function Description Location

a<n>
where n is 
number of 
ports from 
0 upwards

Normal communications port Indicates normal 
communications port 
behaviour.

/dev/term

a<n> Normal communications port 
wait for DCD on open

Indicates a port open will not 
complete unless the DCD 
signal is present.

/dev/cua

a<n> Print device Indicates that device should 
only be used for transparent 
print.

/dev/xprt
SX User Guide 
Under Solaris

Page 193



Under SCO OpenServer

Device node details

Each serial port has three device nodes associated with it. Each node takes the form of a file 
which you can access from operating system utilities and user applications. Details of these 
nodes are shown in the next table.

DTR and RTS signal information

The serial ports on SX serial adaptor cards use the same pin (pin3 on the RJ12 connector 
see Chapter 3 Cabling information) for the Data Terminal Ready and Ready To Send 
signals. The function of the pin depends on the way you open the port as shown in the next 
table.

Device name Function Description Location

ttya1 Normal communications port Indicates normal 
communications port 
behaviour.

/dev

ttyA1 Normal communications port 
wait for DCD on open

Indicates a port open will not 
complete unless the DCD 
signal is present.

/dev

ttya1p Print device Indicates that device should 
only be used for transparent 
print.

/dev

Device name Function  Signal Description

ttya1 Normal communications port. RTS Ready To Send. Used for 
hardware flow control.

ttyA1 Normal communications port 
wait for DCD on open.

DTR Data Terminal Ready. 
This pin cannot be used 
for hardware flow control 
when this type of device is 
opened.
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Under SCO UnixWare

Device node details

Each serial port has three device nodes associated with it. Each node takes the form of a file 
which you can access from operating system utilities and user applications. Details of these 
nodes are shown in the next table.

Device name Function Description Location

a1 Normal communications port Indicates normal 
communications port 
behaviour.

/dev/term

A1 Modem port Indicates a port open will not 
complete unless the DCD 
signal is present.

/dev/term

a1p Transparent print ports Indicates that device should 
only be used for transparent 
print.

/dev/term

Note

You can only open the transparent print port can when the corresponding normal 
port is open.
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Under Windows NT

Device node details

Each serial port has a single device name associated with it: comx

Under Windows 2000/XP/Server 2003/Vista/Server 2008

Device node details

Each serial port has a single device name associated with it: comx

Under Linux

Device node details

Each serial port has two device nodes associated with it. Each node takes the form of a file 
which you can access from operating system utilities and user applications. Details of these 
nodes are shown in the next table.

Device name Function Description Location

ttyX1 Normal communications port Indicates normal 
communications port 
behaviour.

/dev

cvx1 Modem port Indicates a port open will not 
complete unless the DCD 
signal is present.

/dev
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Appendix B Obtaining baud rates above 38400

You need to read 
this appendix if you 
want to...

You need to read this appendix if you want to use baud rates above 38400 under the Solaris, 
SCO OpenServer and SCO UnixWare operating systems with SX.

This appendix provides information about the spxbaudmap utility which allows you to use 
baud rates greater then 384000 when using SX with the Solaris, SCO OpenServer and SCO 
UnixWare operating systems. 

This following sections are included;

• Introduction to spxbaudmap on page 198

• Using spxbaudmap on page 199.
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Introduction to spxbaudmap

Under the Solaris, SCO OpenServer and SCO UnixWare operating systems, the SX software 
includes a utility called spxbaudmap which allows you to set extended baud rates for a given 
port above 38400 by mapping existing baud rates to higher speeds.

Typically, you use spxbaudmap when you want to use peripherals which can operate above 
a baud rate of 38400.

You use spxbaudmap after you have installed and configured your system using the steps 
given in Chapter 2 Installing hardware and software for your operating system. The 
revised settings for a port will be used the next time the port is opened.

Note

This command needs to be run before the affected devices are started.You need to run 
spxbaudmap on each port whose baud rate you want to extend

Hint
You can include the spxbaudmap command in your start up script under the /etc/rc2.d 
directory. 
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Using spxbaudmap

To use spxbaudmap proceed as follows;

1. Decide on the extended baud rate you require and use the next table to determine the 
settings you need to obtain that value.

2. Install and configure your system using the standard baud rate setting needed to obtain 
the extended baud rate you want. See Chapter 2 Installing hardware and software.

3. At the command prompt, type 
spxbaudmap [-f <device>] [-x <n>] [-m <state>] [-q] [-v] and press the Enter key.

Where;

To obtain 
this baud 
rate ..

Set Standard 
baud rate to...
(See page 25)

Set Mapping 
multipier to..

Mapping 
state Example command

14400 600 24 on spxbaudmap -f /dev/term/s1 -x 24 -m on -v

28800 1200 24 spxbaudmap -f /dev/term/s1 -x 24 -m on -v

57600
(2 options)

50 1 spxbaudmap -f /dev/term/s1 -x 1 -m on -v

2400 24 spxbaudmap -f /dev/term/s1 -x 24 -m on -v

115200
(2 options)

110 1 spxbaudmap -f /dev/term/s1 -x 1 -m on -v

4800 24 spxbaudmap -f /dev/term/s1 -x 24 -m on -v

230400 9600 24 spxbaudmap -f /dev/term/s1 -x 24 -m on -v

460800 19200 24 spxbaudmap -f /dev/term/s1 -x 24 -m on -v

921600 38400 24 spxbaudmap -f /dev/term/s1 -x 24 -m on -v

Parameter Description Typical values

device device name /dev/term/a1 or
/dev/ttya1

-x <n> mapping multiplier 1 or 24

state enables or disables baud rate mapping on/off

-q Displays actual baud rate used

-v Echoes the current version of spxbaudmap

NOTE: You have to be logged in as root to use the spxbaudmap 
command.
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For example, having set a suitable standard baud rate, to use port /dev/term/a1 with a 
mapping multiplier of 24 you would type:
spxbaudmap -f /dev/term/a1 -x 24 -m on -v

Then type:
spxbaudmap -f /dev/term/a1 -x 24 -q

And the following line will be displayed:
Mapping: ON Multiplier:24 Baud: 230400

You can now start the device using the revised baud rate.

NOTE: If you already have an application running against the port, you 
need to close the port and then reopen the port to make the change 
take effect.
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Appendix C Transparent printing

You need to read 
this appendix if you 
want to...

You need to read this appendix if you want general background information on transparent 
printing.

This appendix gives an overview of the transparent printing feature offered for the SCO 
OpenServer operating system (although transparent printing can be performed on other 
operating systems, this appendix uses SCO OpenServer for its examples) and includes 
details of configuration files associated with transparent printing. 

This appendix includes the following sections;

• What is transparent printing? on page 202

• Problems with printer output on page 203

• The printcap.si configuration file on page 203

• The print.si configuration file on page 204
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What is transparent printing?

Most terminals have an auxiliary (AUX) port which can be connected to a serial printer. Data 
can then be output to the terminal or the printer via the same serial line. This is called 
transparent print (or print) and is designed for printing simple ASCII text. A separate print 
device node (ttyinp where n is device number) is created for each port. This device is 
enabled automatically if either the local or modem device is enabled for the port.

When a host card receives data addressed to the transparent print device it prefixes it with 
the transparent print mode ON string and appends it with the transparent mode OFF string. 
The ON and OFF strings for each terminal type available are defined by the printcap.si file. 
See The printcap.si configuration file on page 203 for more details.

When the host card receives data addressed to the transparent print device, it prefixes it with 
the Transparent Print Mode ON string and appends it with the Transparent Print Mode OFF 
string. Terminal I/O has absolute priority over printer output. Transparent print data will only 
be sent when there is a break in output to the terminal (for more than a tenth of a second)

For each port, the transparent printing parameters are controlled by an entry in the print.si 
file found in the /etc/ directory on your system. The entry for each port includes definitions of 
the terminal type, transparent print throughput rate and device name. See The print.si 
configuration file on page 204 for further details.

Serial communications 
port on terminal

Terminal
Auxiliary port 
on terminal

Printer

SX Port 
Configuration utility

print.si file 

SX Device driver SX host 
card

SCO OpenServer 
operating system

 Computer system
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Problems with printer output

When you use transparent printing you may obtain incorrect printer output due to the 
following reasons;

Graphics printers may misinterpret some characters output through transparent print. This 
problem is more likely if the terminal is in 7-bit mode, because 8-bit characters will not be 
printed.

Some terminals suppress the output of certain characters to their printer or AUX ports. Such 
terminals can prevent essential control characters from reaching the printer thus generating 
incorrect printer output. This occurrence is extremely unpredictable because of the large 
number of potential hardware configurations.

The printcap.si configuration file

The printcap.si file defines the transparent print ON and OFF strings for each terminal type 
available. When a host card receives data addressed to the transparent print device it 
prefixes it with the transparent print mode ON string and appends it with the transparent 
mode OFF string.

If you don’t configure a specific terminal type printcap.slx will use the default type which is 
“unknown”

anus ^X ^T

Terminal type.

Transparent print ON string.

Transparent print OFF 
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The print.si configuration file

For each port, transparent printing is controlled by an entry in the print.si file. The print.si 
file is found in the /etc/ directory on your system. The entry for each port includes definitions 
of the terminal type, transparent print throughput rate, device name. The content of the 
print.si file is normally controlled automatically by either the Port Configuration utility (SCO 
OpenServer) or the Serial Manager (SCO UnixWare). Under Solaris, you need to edit the file 
using a suitable text editor. A sample entry from a typical print.si file is shown in the next 
example.

100 unknown ttya -ixany -ixon 

Maximum number of characters per second 
throughput for transparent printing.

Device name

Terminal type of terminal to which your printer is 
attached defined in the printcap.si file.

Enables flow control for Transparent printing.

Enables sending of data on receipt of the next character 
(when flow control is enabled on the transparent print port).
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SX
User Guide

Appendix D Troubleshooting

You need to read 
this appendix if you 
want to...

You need to read this appendix if you want information on troubleshooting for the SX serial 
connectivity system.

This appendix provides examples of normal boot up messages and a troubleshooting guide 
including typical problems and corrective action required for all the currently supported 
operating systems.

• Solaris troubleshooting on page 206

• SCO OpenServer troubleshooting on page 210

• SCO UnixWare troubleshooting on page 222

• Windows NT troubleshooting on page 230

• Windows 2000/XP/Server 2003/Vista/Server 2008 troubleshooting on page 233

• Linux troubleshooting on page 236

Note

To contact Perle for technical support. see Appendix E Contacting 
Perle.
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Solaris troubleshooting

This section describes troubleshooting SX products under the Solaris operating system and 
includes the following sections;

• Example of normal boot up messages for host cards on page 207

• General troubleshooting guide on page 208

• Solaris error messages on page 209

Note

To contact Perle for technical support. see Appendix E Contacting Perle.
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Example of normal boot up messages for host cards

The normal messages for satisfactory host card detection and initialisation form part of the 
normal Solaris boot up messages and are shown in the next example. This example shows 
one ISA host card and one PCI host card.

Specialix SX Solaris Driver v1.1.1 Apr 13, 2000

SX Jet PCI at physical address 0xFDFE0000, using IRQ 1

SX ISA at physical address 0xE0000, using IRQ 15

Host card type

Host card message (one per card installed)

IRQ level 

Address range used by host 
card in hexidecimal
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General troubleshooting guide

Problem Action required

Device driver does not start after installation 1. Ensure PCI host cards have been installed.

2. Ensure ISA card settings have been specified.

No host card boot up message 1. Check physical installation of PCI and ISA host 
cards.

2. Check ISA board memory settings and ensure 
they match the settings specified by the sxisacfg 
utility.

3. Check the interrupt setting on ISA host cards to 
see if the interrupt specifies by sxisacfg is 
available for use.

4. For ISA cards check that the memory range is 
enabled in the PCs BIOS.

5. Run the customer dos diagnostics to check 
that the card is not faulty

Host card not recognised by system 1. Check physical installation of PCI and ISA 
host cards, and ensure board correctly seated 
in bus slot. 

2. Check ISA board memory settings, and 
ensure they match the setting specified by the 
sxisacfg file during installation. 

3. Check the interrupt setting on ISA host cards, 
to see if the interrupt specified by the 
sxisacfg file during installation is available for 
ISA use. 

Note that on most systems it is a 
requirement that ISA interrupts are 
reserved in either the BIOS setup, or 
system configuration program.
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Solaris error messages

Error message Reason Action required

Can't locate polling property Missing sx.conf hardware configuration 
file.

1. Remove then reinstall the SX 
device driver and utilities 
software. See page 28

ddi_add_intr failure Failed to configure the interrupt for a 
host card.

1. Select another interrupt using 
sxisacfg utility. See page 31

mod_install() failed Possible memory shortage on 
system

1. Contact technical support.
See page 239

Cannot start the card Host card has been detected but is 
faulty.

1. Replace card.
See page 131 and page 131.

Invalid adapter combination You have installed an invalid 
combination of adaptors to a host 
card.

1. Power down and ensure that the 
adaptor configuration is 
corrected. See page 25.

Host has no ports A host card has no adapters 
connected.

1. Power down and remove the 
host card. See page 135.

Transparent print port still open Tried to close a port with the 
transparent print node still open

1. Close the transparent print port 
then the direct port.

Attempt to open port for both 
local and modem

A port can be opened as a direct or 
a modem port - not both.

1. Close the port.

Attempt to open port that is 
exclusively locked

The port has been opened 
previously with an exclusive lock.

1. Close the port and re-open 
without the exclusive lock

Direct port not open A transparent port has been opened 
without the corresponding direct 
port.

1. Open the corresponding direct 
port.

bad signature Configuration file ISA card details do 
not match the actual ISA card installed 
or no ISA card installed.

Try each of the following in turn;

1. Remove the ISA card.
See page 135.

2. Change ISA card details using 
sxisacfg.
See page 31.

3. Change the ISA card address 
using the on board switches.
See page 133.
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SCO OpenServer troubleshooting

This section describes troubleshooting SX products under the SCO OpenServer operating 
system and includes the following sections;

• Example of a normal boot up messages for host cards on page 211

• General troubleshooting guide on page 212

• SCO OpenServer error messages on page 213

• Testing SX ports with Port Diagnostics on page 215

Note

To contact Perle for technical support. see Appendix E Contacting Perle.
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Example of a normal boot up messages for host cards

The normal messages for satisfactory host card detection and initialisation form part of the 
normal SCO OpenServer 5 boot up messages and are shown in the next example. This 
example shows one ISA host card and one PCI host card.

% SX  host=PCI -SX slot=12 v=2.1.0 ID=1.21
% SX   base = 0xFEDF0000 
% SX  active hosts=1, modules=1, ports=8

% SX  host=ISA -SX slot=12 v=2.1.0 ID=1.21
% SX   base = 0x000D0000 
% SX  active hosts=1, modules=1, ports=8

Host card type

Address range used by 
host card in 

Driver software version

Total number of ports

ISA host card 
message (one 
per card installed)

PCI host card 
message (one per 
card installed)

Host card ID number
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General troubleshooting guide

General faults and suggested actions are shown in the next table.

Problem Action required

Operating system fails to boot 1. Remove host card(s) and reboot the system. 

2. Re-boot your system using the previous kernel. 

3. Re-install the host cards and boot the system using a 
bootable floppy disk.

4. Run diagnostics to check for further problems.

Cards and/or devices not found 1. Run dos diagnostic utility to find out which devices are 
present and their location.

2. Ensure host cards are seated correctly

3. Ensure that cables and device concentrators are 
connected properly.

4. Ensure host cards are set to the correct address.

5. Check that the SX drivers and their configuration are 
set to the latest version.

Can’t obtain login prompt on terminal 1. Check the port status LED on the device 
concentrators.

2. Ensure the login is enabled.

3. Check the terminal and login configuration settings. 

4. Check cables are installed properly. 

Data or login messages are corrupted 1. Ensure that port and device configuration settings 
match.

2. Check cables are properly installed.

3. Run dos diagnostics to check the system.
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SCO OpenServer error messages

Error message Reason Action required

Attempted sleep in si_intr - 
command requested n 
device n

This is a system problem. 1. Contact Technical Support. See 
Appendix E Contacting Perle.

SX: command stack - 
completing n requested n 
device n

This is a system problem. 1. Contact Technical Support. See 
Appendix E Contacting Perle.

SX: Extra ports on card at 
<address> ignored

The driver has detected more ports 
than it can support. This means that 
you have connected more than four 
device concentrators to the host card. 

1. Power your system down and 
remove the surplus host card(s). 
See page 135.

SX: ISA host card has invalid 
address - card ignored

You have installed your host card at an 
invalid address. 

1. Check that the switches on ISA 
host cards are set to a valid 
address. See page 133.

SX: ISA host cards cannot 
share addresses - card 
ignored

You have attempted to install two host 
cards at the same address. 

1. Switch your machine off.

2. Remove one of the host cards, 
See page 135.

3. On the removed card set a new 
address. See page 133.

SX: ISA host cards cannot 
share interrupt levels - card 
ignored

You have selected an interrupt already 
in use by another host card. 

1. Re-install the SX device drivers 
and select a different interrupt or 
polled mode. See page 78.

SX: Invalid card type - card 
ignored

The device driver's configuration table 
has become corrupted. 

1. Re-install the SX device drivers 
software. See page 78.

SX: Invalid interrupt level - 
card ignored

You have selected an interrupt level 
that doesn't exist, or is already being 
used. 

1. Re-install the SX device drivers 
and select a different interrupt or 
polled mode. See page 78.

Invalid interrupt selected, 
using 15

You have selected an invalid interrupt 
level, so the device driver has selected 
the default (15) for you.

1. Select a valid interrupt level. 
See page 85.

SX: Warning SX interrupt 
handler re-entered

This is a system problem 1. Contact Technical Support. See 
Appendix E Contacting Perle.

WARNING: Host 
@0xnnnnnnnn SHUTDOWN

No ports detected

The host card at the specified address 
has been shutdown by the driver 
because it reported a zero port count. 

1. Ensure the host card, device 
concentrators and associated 
cables are installed securely. 
See page 131, page 133 and 
page 136.
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WARNING: Host 
@0xnnnnnnnn SHUTDOWN

Mixed adapter types not 
allowed

The host card at the specified address 
has been shutdown by the driver 
because it reported an illegal 
combination of device concentrator 
(terminal adapter) types. 

1. Shutdown the system and 
ensure that each host card has 
only one type of device 
concentrator connected. See 
page 136.

WARNING: No active Host 
Cards

Either you do not have any host cards 
installed, or, those that are installed 
suffer from one or more of the ‘Host 
SHUTDOWN’ scenarios above. 

1. Ensure the host card, device 
concentrators and associated 
cables are installed securely. 
See page 131, page 133 and 
page 136.

WARNING: No active 
Terminal Adapters

At least one host card is active, but the 
total active port count on your SX 
installation is ZERO.

1. Ensure the host card, device 
concentrators and associated 
cables are installed securely. 
See page 131, page 133 and 
page 136.

2. Re-install the SX device drivers 
software. See page 78.

Error message Reason Action required
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Testing SX ports with Port Diagnostics

The SX Serial Port Enable utility includes a Port Diagnostics tool. The Port Diagnostics tool 
allows you to Run tests on the port currently selected in Serial Port Enable, display modem 
pin status and stty attribute settings. See the following sections for details;

• Running tests on a port on page 216

• Performing a write test on page 218

• Performing a loopback test on page 219

• Displaying port settings on page 220

• Displaying modem pin settings on page 221

For related information, see also Connecting Device Concentrators to terminals on 
page 165 and Loopback connector pinouts on page 178 in Chapter 3 Cabling 
information.
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Running tests on a port

To run tests on a port proceed as follows;

1. Start the Serial Port Enable Utility, see Configuring SX serial ports on page 55 in 
Chapter 2 Installing hardware and software.

2. In the Serial Port Enable menu, click on the Diags > Test option.

The Port Diagnostics window is now displayed.
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3. Using the Port Diagnostics menu, choose the settings you want to use for testing the 
currently selected port using the options shown in the next table;

You can now perform one the tests available in Port Diagnostics as detailed in the next table;

To set this parameter Use one of these menu options

Baud rate Baud > 2400
Baud > 4800
Baud > 9600
Baud > 19200

Number of stop bits Stop > 1
Stop > 2

Flow control Flow > xon/xoff
Flow > rts/cts
Flow > None

Size Size > 5
Size > 6
Size > 7
Size > 8

Parity 
Parity > None
Parity > Even
Parity > Odd

Test For details see....

Write test Performing a write test on page 218

Loopback 
test

Performing a loopback test on page 219

Hint

To pause a test proceed as follows:

• In the Port Diagnostics window, click on the 
Pause Testing Button.
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Performing a write test

The write test allows you to verify that data is sent out from the selected port properly. For 
example, you might use this test if you cannot obtain a login. 

To perform this test proceed as follows;

1. Connect a terminal to the port you want to test using the cable type recommended in 
Connecting Device Concentrators to terminals on page 165 in Chapter 3 Cabling 
information.

2. Start and set up the Port Configuration utility using the procedure given in Testing SX 
ports with Port Diagnostics on page 215.

3. In the Port Diagnostics window, click on the Start Write Test button.

The write test is now performed by the software and the Port Diagnostics window updated to 
show the result of the test in the lower half of the window. During the test the value displayed 
in the Line Out field should increase in proportion to the volume of data being sent.

The output on the terminal screen should be a steady scrolling text pattern. If not, then your 
terminal settings do not match your port settings. 
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Performing a loopback test

A loopback test allows you to check that the selected port is receiving and sending data 
correctly. For example, you might use this test if you are using a modem and your remote site 
reports corrupted data.

This involves attaching a loopback connector to the selected port on a device concentrator, 
then performing the test and displaying the results from within the Port Diagnostics window. 

To perform this test proceed as follows;

1. Connect a loopback connector to the port on you want to test the device concentrator. 
See Loopback connector pinouts on page 178 in Chapter 3 Cabling information

2. Start and set up the Port Configuration utility using the procedure given in Testing SX 
ports with Port Diagnostics on page 215.

3. In the Port Diagnostics window, click on the Start Loopback Test button.

The software now performs the loopback test and displays the results in the bottom half of 
the Port Diagnostics window. During the test, the values in the Lines In and Lines Out 
fields should increase in proportion to the volume of data being transferred

Note

The type of loopback connector you require depends on the Device 
concentrator and associated connector types you are using.
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Displaying port settings

To display the tty attributes for the currently selected port proceed as follows;

1. Start the Serial Port Enable Utility, see Configuring SX serial ports on page 55 in 
Chapter 2 Installing hardware and software.

2. In the Serial Port Enable menu, click on the Diags > Settings option.

The Port Settings window is now displayed.

3. When you have observed the settings you require, click on the Exit button to close the 
window.
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Displaying modem pin settings

To display the modem pin settings for the currently selected port proceed as follows;

1. Start the Serial Port Enable Utility, see Configuring SX serial ports on page 55 in 
Chapter 2 Installing hardware and software.

2. In the Serial Port Enable menu, click on the Diags > Pins option.

The Port Pin Status window is now displayed.

3. When you have observed the settings you require, click on the Done button to close the 
window.
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SCO UnixWare troubleshooting

This section describes troubleshooting SX products under the SCO UnixWare operating 
system and includes the following sections;

• Example of a normal boot up messages for host cards on page 223

• General troubleshooting guide on page 224

• SCO UnixWare error messages on page 225

Note

To contact Perle for technical support. see Appendix E Contacting Perle.
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Example of a normal boot up messages for host cards

The normal messages for satisfactory host card detection and initialisation form part of the 
normal SCO UnixWare boot up messages and are shown in the next example. This example 
shows one ISA host card and one PCI host card.

Specialix SX UnixWare Driver v3.1.0

SX: SX PCI host card Host Card at bus address 0xFEDF0000 using IRQ 5
SX one host card 0 modules 0 ports

SX: SX ISA host card Host Card at bus address 0xFEDF0000 using IRQ 5
SX one host card 0 modules 0 ports

IRQ level Host card type

PCI host card 
message (one per 
card installed)

ISA host card 
message (one 
per card installed)
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General troubleshooting guide

General faults and suggested actions are shown in the next table.

Problem Action required

Operating system fails to boot 1. Remove host card(s) and reboot the system. 

2. Re-boot your system using the previous kernel. 

3. Re-install the host cards and boot the system using a 
bootable floppy disk.

4. Run diagnostics to check for further problems.

Cards and/or devices not found 1. Run dos diagnostic utility to find out which devices are 
present and their location.

2. Ensure host cards are seated correctly

3. Ensure that cables and device concentrators are 
connected properly.

4. Ensure host cards are set to the correct address.

5. Check that the SX drivers and their configuration are 
set to the latest version.

Can’t obtain login prompt on terminal 1. Check the port status LED on the device 
concentrators.

2. Ensure the login is enabled.

3. Check the terminal and login configuration settings.

4. Check cables are installed properly. 

Data or login messages are corrupted 1. Ensure that port and device configuration settings 
match.

2. Check cables are properly installed.

3. Run dos diagnostics to check the system.

System hangs 1. Using a suitable text editor open the Space.c file 
located in the UW/slx/ directory.

2. Within the Space.c file edit the int slx_PLXFix = 0; 
line to read; int slx_PLXFix = 1;

3. Save and close the Space.c file

4. Re-start your system.

5. If this fails, contact technical support.
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SCO UnixWare error messages

Error message Reason Action required

An attempt has been made 
to open port n  while a close 
on that port is in progress.

The streams system has called the 
driver open routine to open a port which 
it is in the process of closing. 

This indicates a fault in the 
implementation of streams within the 
operating system. 

1. Note down the values given in 
the error message, and 
contact Technical Support. 
See Appendix E Contacting 
Perle.

Cannot use both polled and 
interrupt driven host cards in 
one system. All the cards 
will be reconfigured to use 
polled operation.

The SX device driver can run in polled 
mode or interrupt mode, not both at the 
same time. You have installed one or 
more host cards running in interrupt 
mode and one or more host cards 
running in polled mode. The driver has 
set all your host cards to polled mode. 

1. For ISA host cards, re- install 
the SX device drivers, setting 
all your host cards to the same 
mode. See page 78.

Can't patch interrupt vector 
number n.

An interrupt level above 15 has been set 
for a host card. 

1. Re-install the SX device driver. 
See page 78.

Interrupt handler re-entered! 
This 
vector = n, other vector = n, 
 this flag = n, other flag = n.

The interrupt handling software has 
been called whilst the driver has been 
processing a previous interrupt. This 
should not happen as the driver protects 
itself against this occurring. It may be 
caused by the operating system using 
different spl protection levels for streams 
to the levels used by the SX driver.

1. Note down the values given in 
the error message, and 
contact Technical Support. 
See Appendix E Contacting 
Perle.

Message type n received by 
write service routine - 
dumped.

An unexpected message has been sent 
to the device driver service routine. This 
indicates a fault in the implementation of 
streams within the operating system. 

1. Note down the values given in 
the error message, and 
contact Technical Support. 
See Appendix E Contacting 
Perle.

No host cards detected in 
system.

The driver has been unable to detect 
any host cards. 

1. Ensure host cards are seated 
correctly. See page 131 and 
page 133.

2. Check that the switches on 
ISA host cards are set to a 
valid address. See page 133.

3. If this fails to solve the 
problem, re-install the 
SXdevice drivers. See page 
78.
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SX: one host card failed to 
run   SX: n host cards failed 
to run.

One or more of your host cards have 
failed to start up correctly.

1. Ensure the host card, device 
concentrators and associated 
cables are installed securely. 
See page 131, page 133 and 
page 136.

2. Ensure there are a maximum 
of four host cards installed. 
See page 78.

3. Check that the host card isn't 
sharing a memory address. 
See page 78.

Port n has been re-opened, 
the queue passed to open is 
the same as for the previous 
open, but the private data 
structure pointer has 
changed. The read queue 
pointer is at address 
0xXXXXX and the private 
data structure entry should 
be 0xXXXXX but is now 
0xXXXXX. This Unix system 
may fail soon!

The driver has tried unsuccessfully to 
recover and it is possible that the 
system will crash.

1. Note down the values given in 
the error message and contact 
Technical Support. See 
Appendix E Contacting 
Perle.

Startup timeout on ISA host 
card at base address 
0xXXXXX
Startup timeout on PCI host 
card in slot n.

The identified host card has failed to 
execute its download code. 

1. Ensure the host card, device 
concentrators and associated 
cables are installed securely. 
See page 131, page 133 and 
page 136.

2. Ensure there are a maximum 
of four host cards installed. 
See page 78.

3. Check that the host card isn't 
sharing a memory address. 
See page 78.

Streams error - asked to 
close (xprint)  queue 
0xXXXXX. Private pointer is  
0xXXXXX, minimum 
acceptable level is  
0xXXXXX, maximum 
acceptable level is 0xXXXXX.

The driver has detected that the data 
structures associated with its streams 
interface have been corrupted. 

1. Note down the values given in 
the error message and contact 
Technical Support. See 
Appendix E Contacting 
Perle.

Error message Reason Action required
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There are more than 4 host 
cards installed in this 
machine. Extra host cards 
will be ignored.

The driver has detected more than four 
host cards.

1. Power your system down and 
remove the surplus host 
card(s). See page 135.

XPRINT message type n 
received by write service 
routine - dumped.

An unexpected message has been sent 
to the device driver service routine.

1. Note down the values given in 
the error message and contact 
Technical Support. See 
Appendix E Contacting 
Perle.

Xprint port n has been re-
opened, the queue passed to 
open is the same as for the 
previous open, but the 
private data structure pointer 
has changed. The read 
queue pointer is at address 
0xXXXXX and the private 
data structure  entry should 
be 0xXXXXX but is now  
0xXXXXX. This Unix system 
may fail soon!

The streams implementation on this 
operating system has changed some of 
the driver's private data. The driver has 
tried unsuccessfully to recover and it is 
possible that the system will crash. 

1. Note down the values given in 
the error message and contact 
Technical Support. See 
Appendix E Contacting 
Perle.

WARNING: Host n 
SHUTDOWN - invalid 
adapter(s).

The identified host card has been 
shutdown by the SX device driver 
because it reported that it has detected 
more than one type of device 
concentrator (terminal adapter) 
connected. Mixing different types of 
device concentrators is not allowed

1. Install the correct type of 
device concentrators. See 
page 136 and page 149.

2. Re-start your system.

WARNING: ISA card not 
found at address : 0xXXXXX

The SX device driver is unable to find an 
SX ISA Host Card at the address 
defined by the DCU.

1. Check the address settings on 
the ISA host card. See page 
133.

An attempt has been made 
to open port n  while a close 
on that port is in progress.

The streams system has called the 
driver open routine to open a port which 
it is in the process of closing. This 
indicates a fault in the implementation of 
streams within the operating system.

1. Note down the values given in 
the error message and contact 
Technical Support. See 
Appendix E Contacting 
Perle.

Cannot use both polled and 
interrupt driven host cards in 
one system. All the cards 
will be reconfigured to use 
polled operation.

You have installed one or more host 
cards running in interrupt mode and one 
or more host cards running in polled 
mode. The driver has set all your host 
cards to polled mode. 

1. For ISA host cards, re- install 
the SX device drivers. See 
page 78.

2. set all your host cards to the 
same mode. See page 78.

Can't patch interrupt vector 
number n.

An interrupt level above 15 has been set 
for a host card. 

1. Re- install the SX device 
drivers. See page 78.

Error message Reason Action required
SX User Guide 
SCO UnixWare troubleshooting

Page 227



Interrupt handler re-entered! 
This 
vector = n, other vector = n, 
 this flag = n, other flag = n.

The interrupt handling software has 
been called whilst the driver has been 
processing a previous interrupt. 

1. Note down the values given in 
the error message and contact 
Technical Support. See 
Appendix E Contacting 
Perle.

Message type n received by 
write service routine - 
dumped.

An unexpected message has been sent 
to the device driver service routine.

1. Note down the values given in 
the error message and contact 
Technical Support. See 
Appendix E Contacting 
Perle.

No host cards detected in 
system.

The driver has been unable to detect 
any host cards. 

1. Ensure the host card, device 
concentrators and associated 
cables are installed securely. 
See page 131, page 133 and 
page 136.

2. Ensure there are a maximum 
of four host cards installed. 
See page 78.

3. Check that the host card isn't 
sharing a memory address. 
See page 78.

SX: one host card failed to 
run   SX: n host cards failed 
to run.

One or more of your host cards have 
failed to start up correctly. 

1. Ensure the host card, device 
concentrators and associated 
cables are installed securely. 
See page 131, page 133 and 
page 136.

2. Ensure there are a maximum 
of four host cards installed. 
See page 78.

3. Check that the host card isn't 
sharing a memory address. 
See page 78.

Port n has been re-opened, 
the queue passed to open is 
the same as for the previous 
open, but the private data 
structure pointer has 
changed. The read queue 
pointer is at address 
0xXXXXX and the private 
data structure entry should 
be 0xXXXXX but is now 
0xXXXXX. This Unix system 
may fail soon!

The streams implementation on this 
operating system has changed some of 
the driver's private data. The driver has 
tried unsuccessfully to recover and it is 
possible that the system will crash.

1. Note down the values given in 
the error message and contact 
Technical Support. See 
Appendix E Contacting 
Perle.

Error message Reason Action required
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Startup timeout on ISA host 
card at base address 
0xXXXXX
Startup timeout on PCI host 
card in slot n.

The identified host card has failed to 
execute its download code. 

1. Ensure the host card, device 
concentrators and associated 
cables are installed securely. 
See page 131, page 133 and 
page 136.

2. Ensure there are a maximum 
of four host cards installed. 
See page 78.

3. Check that the host card isn't 
sharing a memory address. 
See page 78.

Streams error - asked to 
close (xprint)  queue 
0xXXXXX. Private pointer is  
0xXXXXX, minimum 
acceptable level is  
0xXXXXX, maximum 
acceptable level is 0xXXXXX.

The driver has detected that the data 
structures associated with its streams 
interface have been corrupted. This is 
an error in the implementation of 
streams within the operating system. 

1. Note down the values given in 
the error message and contact 
Technical Support. See 
Appendix E Contacting 
Perle.

XPRINT message type n 
received by write service 
routine - dumped.

This message indicates that an 
unexpected message has been sent to 
the device driver service routine.

This indicates a fault in the 
implementation of streams within the 
operating system.

1. Note down the values given in 
the error message and contact 
Technical Support. See 
Appendix E Contacting 
Perle.

Error message Reason Action required
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Windows NT troubleshooting

This section describes troubleshooting SX products under the Windows NT operating system 
and includes the following sections;

• General troubleshooting under Windows NT on page 231

• Windows NT error messages on page 232.

Note

To contact Perle for technical support. see Appendix E Contacting Perle.
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General troubleshooting under Windows NT

Problem Action required

Machine fails to boot. 1. Turn off your machine, remove SX card(s) and 
reboot. See page 135.

2. In the BIOS setup, make sure memory and 
interrupts levels are reserved for any ISA cards 
fitted.

3. Check the memory address switch settings on 
any ISA cards fitted. See page 133.

4. Try installing a different host card in case the one 
currently installed is faulty. See page 133.

Windows NT operating system fails while 
loading and the system hangs.

1. Reboot machine and then switch to the last 
known good configuration.

2. Check for resource conflicts or faulty hardware.

3. Turn off machine, remove any SX cards fitted 
(page 135) and then reboot your system.

4. Once the machine boots properly, change the 
configuration settings of the SX card to match those in 
the BIOS setup. See page 133.

Windows NT operating system fails while 
loading and displays a blue screen.

1. Note the five hexadecimal numbers at the top line 
of the screen 

2. Reboot your machine and then switch to the last 
known good configuration.

3. Check for resource conflicts or faulty hardware.

4. Turn off machine, remove any SX cards fitted 
(page 135) and then reboot your system.

5. Once the machine boots properly, change the 
configuration settings of the SX card to match those in 
the BIOS setup. See page 133.

NT operating system loads OK, but SX driver or 
another driver fails to boot

A window entitled "Service Control Manager" is 
displayed with the message:

At least one service or driver failed 
during startup.  Use Event Viewer to 
examine the event log for details.

1. Check the Windows NT Event Viewer; and follow 
the actions suggested to you by the system.

2. Run Windows NT Diagnostics to find available 
IRQ and memory addresses. (You may need to 
reserve settings in the BIOS setup).

SX ports do not work after installation. 1. Check the Windows NT Event Viewer and follow 
the suggested actions. 
SX User Guide 
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Windows NT error messages

In the event of any error messages check the Windows NT Event Log. See your Windows 
NT user documentation or help system for details.

For general problems see General troubleshooting under Windows NT on page 231.

SX NT driver fails during normal operation, 
symptom: blue screen

1. Note the five hexadecimal numbers displayed at 
the top line of the screen.

2. Reboot your machine and then switch to the last 
known good configuration.

3. Check for resource conflicts or faulty hardware.

4. Turn off machine, remove any SX cards fitted 
(page 135) and then reboot your system.

5. Once the machine boots properly, change the 
configuration settings of the SX card to match those in 
the BIOS setup. See page 133.

SX NT driver fails during normal operation, 
symptoms either:

black screen, machine reboots or system hangs

1. Contact Technical Support. See Appendix E 
Contacting Perle.

Problem Action required
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Windows 2000/XP/Server 2003/Vista/Server 2008 
troubleshooting

This section describes troubleshooting SX products under the Windows 2000/XP/
Server 2003/Vista/Server 2008 operating system and includes the following sections;

• General troubleshooting under Windows 2000/XP/Server 2003/Vista/Server 2008 on 
page 234

• Windows 2000/XP/Server 2003/Vista/Server 2008 error messages on page 235.

Note

To contact Perle for technical support. see Appendix E Contacting Perle.
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General troubleshooting under Windows 2000/XP/Server 2003/Vista/Server 2008

Problem Action required

Machine fails to boot. 1. Turn off your machine, remove SX card(s) and 
reboot. See page 135.

2. In the BIOS setup, make sure memory and 
interrupts levels are reserved for any ISA cards 
fitted.

3. Check the memory address switch settings on 
any ISA cards fitted. See page 133.

4. Try installing a different host card in case the one 
currently installed is faulty. See page 133.

Windows operating system fails while loading 
and the system hangs.

1. Reboot machine and then switch to the last 
known good configuration.

2. Check for resource conflicts or faulty hardware.

3. Turn off machine, remove any SX cards fitted 
(page 135) and then reboot your system.

4. Once the machine boots properly, change the 
configuration settings of the SX card to match those in 
the BIOS setup. See page 133.

Windows operating system fails while loading 
and displays a blue screen.

1. Note the five hexadecimal numbers at the top line 
of the screen 

2. Reboot your machine and then switch to the last 
known good configuration.

3. Check for resource conflicts or faulty hardware.

4. Turn off machine, remove any SX cards fitted 
(page 135) and then reboot your system.

5. Once the machine boots properly, change the 
configuration settings of the SX card to match those in 
the BIOS setup. See page 133.

Operating system loads OK, but SX driver or 
another driver fails to boot

1. Run Windows Device Manager to find available 
IRQ and memory addresses.

SX ports do not work after installation. 1. Check the Windows Event Log and follow the 
suggested actions. 
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Windows 2000/XP/Server 2003/Vista/Server 2008 error messages

In the event of any error messages, check the Windows Event Log. Also open the Windows 
Device Manager and check for warming icons on the installed hardware. See your Windows 
user documentation or help system for details.

For general problems, see General troubleshooting under Windows 2000/XP/Server 
2003/Vista/Server 2008 on page 234.

SX Windows driver fails during normal 
operation, symptom: blue screen

1. Note the five hexadecimal numbers displayed at 
the top line of the screen.

2. Reboot your machine and then switch to the last 
known good configuration.

3. Check for resource conflicts or faulty hardware.

4. Turn off machine, remove any SX cards fitted 
(page 135) and then reboot your system.

5. Once the machine boots properly, change the 
configuration settings of the SX card to match those in 
the BIOS setup. See page 133.

SX Windows driver fails during normal 
operation, symptoms either:

black screen, machine reboots or system hangs

1. Contact Technical Support. See Appendix E 
Contacting Perle.

Problem Action required
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Linux troubleshooting

This section describes troubleshooting SX products under the Linux operating system and 
includes the following sections;

• General troubleshooting under Linux on page 236

• Linux error messages on page 237.

General troubleshooting under Linux

Note

To contact Perle for technical support. see Appendix E Contacting Perle.

Problem Action required

Machine fails to boot. 1. Turn off your machine, remove SX card(s) and 
reboot. See page 135.

2. Ensure memory and interrupts levels are reserved 
for any ISA cards fitted.

3. Check the memory address switch settings on 
any ISA cards fitted. See page 133.

4. Try installing a different host card in case the one 
currently installed is faulty. See page 133.

Linux operating system fails while loading and 
the system hangs.

1. Reboot machine and then switch to the last 
known good configuration.

2. Check for resource conflicts or faulty hardware.

3. Turn off machine, remove any SX cards fitted 
(page 135) and then reboot your system.

Linux operating system fails while loading and 
displays a blue screen.

1. Reboot your machine and then switch to the last 
known good configuration.

2. Check for resource conflicts or faulty hardware.

3. Turn off machine, remove any SX cards fitted 
(page 135) and then reboot your system.

SX Linux driver fails during normal operation, 
symptoms either:

black screen, machine reboots or system hangs

1. Contact Technical Support. See Appendix E 
Contacting Perle.
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Linux error messages

In the event of any error messages check the messages file in the /var/log directory. See 
your Linux user documentation or help system for details.

For general problems see General troubleshooting under Linux on page 236.
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Appendix D Contacting Perle

You need to read 
this appendix if you 
want to...

You need to read this appendix if you want to contact Perle for technical support or any other 
queries about this product.

This appendix includes the following sections;

• Making a technical Support Query on page 109

• Repair procedure on page 112

• Feedback about this manual on page 112

• Contacting Perle technical support on page 113

Internet access

Email

Click here to access the our website at 
the following URL: 

http://www.perle.com 

Click here to email Perle at the following address;

Email: ptac@perle.com 
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Making a technical Support Query

This section contains the following information about making a query;

• Who to contact on page 109

• Information needed when making a query on page 110

• Making a support query via the Perle web page on page 111

Who to contact

If you bought your product from a registered Perle supplier, you must contact their Technical 
Support department; they are qualified to deal with your problem.

If you are a registered Perle supplier, and bought your product from Perle, contact Perle 
Technical Support using the details given in Contacting Perle technical support on 
page 113.
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Information needed when making a query

When you make a technical support enquiry please have the following information ready;

Hint

Print out this page and fill in the table provided with the basic 
information you need.

Item Write details here

Product name and version

Problem description

Operating system version

Driver version

Details of any other cards 
installed in your system

Your name

Company Name

Country

Phone number

Fax number

Email address (if available)
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Making a support query via the Perle web page

If you have an internet connection, please send details of your problem to Technical Support 
using the email links provided on the Perle web site in the ‘Support’ area.

See also Contacting Perle technical support on page 113 for email links and other contact 
details for the Perle technical support centres.

Click here to access our website at the following URL:

http://www.perle.com
  
Making a technical Support Query
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Repair procedure

Before sending a unit for repair, you must contact your Perle supplier. If, however, you bought 
your product directly from Perle you can contact directly. See Contacting Perle technical 
support on page 113 for contact information.

Customers who are in Europe, Africa or Middle East can submit repair details via a website 
form shown in the next picture. This form is on the Perle website, www.perle.com, in the 
Support area.

In the USA and Asia contact the office shown in the Technical Support section.

Feedback about this manual

If you have any comments or suggestions for improving this manual please email Perle using 
the following address;

Email: ptac@perle.com 

Please include the title, part number and date of the manual (you can find these on the title 
page at the front of this manual).

Click here to access our web site at the following URL:

http://www.perle.com/support_services/rma_form.asp 
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Contacting Perle technical support

Note

Perle offers free technical support to Perle Authorised Distributors and Registered Perle 
Resellers. 

To access technical support please visit the Perle website at 
www.perle.com/support_services/index.shtml.

If you are unable to find the information you require, please feel free to contact our 
technical support teams by email using the addresses shown in the next table.

Region Address Email
North America Perle Systems Ltd.

60 Renfrew Drive
Markham
Ontario
Canada
L3R OE1

Email: ptac@perle.com 

Europe Perle Systems Europe Ltd. 
3 Wintersells Road 
Byfleet Surrey
KT14 7LF
UK

Email: ptac@perle.com 

Asia Perle Asia Pacific (Pte) Ltd.
190 Middle Road
#19-05 Fortune Centre
Singapore 188979

Email: ptac@perle.com 

Worldwide Perle Systems Ltd.
60 Renfrew Drive
Markham
Ontario
Canada
L3R OE1

Email: ptac@perle.com 
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